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Micro Focus Enterprise Test Server 4.0
Release Notes
These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.
Note:
•

•

This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.
Check the Product Documentation section of the Micro Focus SupportLine Web site for any
updates to the documentation which might have been uploaded.

Product Overview
Enterprise Test Server is a test execution environment that allows you to test mainframe applications on a
low cost Windows platform. You can use variables or the tilde syntax to relieve the mainframe test
bottleneck by allowing you to perform a substantial part of your application testing on Windows prior to
moving the application back to the mainframe for final pre-production testing and deployment.
Enterprise Test Server supports IBM COBOL, High Level Assembler, CICS, IMS TM and DB, JCL, DB2,
and z/OS file formats. It also supports common batch utilities such as SORT. This means that applications
running under Enterprise Test Server behave just as they would on the mainframe, so you can perform a
wide variety of pre-production testing activities on low-cost hardware rather than on the mainframe.
To configure Enterprise Test Server your development administrator will work with the development teams
to set up the Enterprise Test Server environment on your central Windows test server, as follows:
1. Enterprise Developer is used to recompile application source code for execution on Windows.
2. Test data sets or databases are made available either locally or on the mainframe through remote
access.
3. Development and test teams are trained to ensure that they understand how to test applications within
the Enterprise Test Server environment and to switch between the different test regions it supports.
Enterprise Test Server comes in the following product variants:
•
•

Enterprise Test Server which is the standard Test Server product and is a mainframe Test Execution
environment.
Enterprise Test Server Premium which provides two additional capabilities to extend the test execution
platform:
•
•

Data Manager, which allows you to subset and mask mainframe data which is then available for
testing under Enterprise Test Server.
Test Automator which is a test automation capability that allows you to create automated test suites
that can be played back against Enterprise Test Server or against the host.

Upgrading from earlier Micro Focus products
Version 4.0 of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with an earlier version of your
product might not be compatible with version 4.0 run-time products. If the behavior of your application
changes with version 4.0, we strongly recommend that you relink the main executable with version 4.0.
This will ensure that the COBOL run-time system fully handles any run-time error conditions that might
occur.
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A new executable that is fully compatible with version 4.0 can be produced without recompiling the
application, as long as the original object code is available and it is relinked with version 4.0.
To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.
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What's New
This release provides enhancements in the following areas:
•
•
•
•
•
•
•
•
•
•
•
•

Application Server JCA Support for Enterprise Server
Data File Tools
Docker
Enterprise Server
File Handler
HCO for DB2 LUW
IMS support
JCL support
Mainframe Access
Managed COBOL
OpenESQL
Platform support

Application Server JCA Support for Enterprise Server
Back to Top
This release includes the following enhancements:
•
•
•

COBOL Resource Adapters now support WebSphere 9.0 and WebLogic 12.2.1.
Tomcat 7.0 support for servlet generation with J2SEBeans.
NullSearch utility - for COBOL resource adapters, this new utility provides assistance in locating NULL
fields in mappings passed to Enterprise Server. When a large number of arguments is provided in the
parameters passed to Enterprise Server, it is difficult to locate NULL fields, which are not allowed. The
NullSearch utility isolates NULL fields, so the Java application can be corrected.

Data File Tools
Back to Top
It is now possible to export any filtered results. When filtering a data file, you can use the results to create a
new data file - click Search > Export Results when a filter is applied to save the filtered records to a new
file. You can:
•
•
•
•

Save the filtered records to a new file.
Save the records that match the specified filter (such as customer information or orders).
Download a subset of the data from a remote file.
Save a small portion of the data for testing purposes.

Docker
Back to Top
This release provides support to enable you to run your COBOL and PL/I applications in Docker
containers, taking advantage of the many benefits offered by the Docker platform such as portability,
performance, agility, isolation, and scalability.
Enterprise Server
Back to Top

6

| What's New

The following enhancements have been made to Enterprise Server:
•

Conversation filtering - the Enterprise Server Communications Process (MFCS) can now restrict access
to listeners by client address. You can specify any permitted or forbidden addresses either by IP
address, network mask, or domain name, and use wildcards. Filters can be applied to individual
listeners, communications processes, or to entire regions. More specific filter rules override any general
ones.

•

The Enterprise Server Security Facility now starts throttling Verify requests when it receives more than
100 requests per second.
This can be used to limit the effectiveness of denial-of-service and brute force attacks. You can
configure the value where throttling occurs. See Verify Request Throttling for more information.

•

(Technology Preview only) Support for adding, deleting, and modifying XA resources in a live Enterprise
Server region.
It is now possible to add, edit, or delete XA resources while an enterprise server instance is running.
Any changes made come into effect after any in-flight transactions have completed. The ability to make
these changes in a live environment comes under the control of the existing enterprise server
permissions.

•

XA-compliant Resources (XARs) - this release provides enhanced CTF tracing that allows more flexible
reporting of warnings and errors on the RM switch module level.

•

A new Communications Server resource class - enables you to control the access to the Enterprise
Server Console Log and Communications Server Log when external security is in effect for an
enterprise server region; see Resource Classes for Communications Server for more information.

•

Improved catalog availability - there is now an improved resilience to temporary communication issues
with the catalog and error reporting enabling a region to stay active if a region has multiple catalogs
defined and one of the catalogs is not available.

•

Enhanced SSL/TLS certificate support - for communications with TLS (formerly SSL), additional
certificate and key file formats are supported. Servers may now be configured with both an RSA and an
ECC key and certificate.
Enhanced SSL/TLS cipher configuration - for communications with TLS (formerly SSL), the permitted
cipher suites and their preferred order can now be configured. The minimum size of Diffie-Hellman
groups for DH key exchange can also be configured. The defaults have been made more secure.

•

•

•

The Historical Statistics Facility (HSF) now enables you to write user-defined data to the records
produced within a .csv file. Use the ES_WRITE_CUSTOM_HSF or ESCSTHSF library routines within
your COBOL programs to define the custom data, and use the ES_HSF_CFG environment variable to
configure up to five custom fields in the generated record.
You can also use the ES_HSF_CFG environment variable to configure the number of CICSF, TSQ, and
TDQ fields that are written to the record.

File Handler
Back to Top
This release provides the following enhancements:
•
•

The DFSORT and SYNCSORT emulations now support the NULLOFL parameter of the OUTFIL
statement.
The ASCIISOSI configuration option is now available. It adds the required SOSI characters to the
relevant EBCDIC DBCS character strings in order for them to be displayed or written out correctly.

HCO for DB2 LUW
Back to Top
This release includes the following new features:
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•
•
•
•

Support for CHARSET EBCDIC COBOL stored procedures
Seamless integration with DB2 LUW SBCS databases, providing various EBCDIC collation sequences
64-bit HCO command-line tools are now available across all supported platforms
HCO DCLGEN enhancements that provide more copybook generation options

IMS support
Back to Top
This release introduces the following new features:
•

•

The IMS Database Forward Recovery feature has been updated to provide point-in-time forward
recovery that enables you to recover all database transactions completed up to a specified point in time,
including date and time of day.
Support for export and import of IMS-configured enterprise server regions through Server Explorer.

JCL support
Back to Top
This release introduces the following new features and enhancements:
•

•

•

•

Micro Focus FTP utility - you can now configure MFFTP to not process trailing blank spaces for a GET
command, by setting the new control variable MFFTP_PROCESS_TRAILS_ONGET=FALSE and
setting the LOCSTAT value TRAILINGBLANKS=FALSE.
A new API has been introduced - MVSSPLPB - that enables you to search all job information held in the
JES spool control files. It is more comprehensive that the existing MVSCASPB API, and should instead
be used for all new spool enquiries.
A number of new environment variables have been introduced that enable you to configure the JES
startup behavior with regards to opening user catalog files. You can configure JES to open user catalog
files only when they are required (and not during system startup), and you can configure JES to retry
opening a catalog file that has failed to open. These changes increase the resilience of the JES system,
as you can mitigate against JES startup failures if the user catalog files are not readily available whilst
the region starts.
The public catalog API, MVSCATPB, has been enhanced to better report on file errors when opening
catalog files. The following new functions have been added to mfpubcat.cpy: GCFS, GNFS, STNI,
GCFE, and GNFE.

Mainframe Access
Back to Top
The installation process has been changed as follows:
•
•
•

A single installer for both Mainframe Access and the Mainframe Access z/Server support is provided.
There is now only one XML configuration file for Mainframe Access. There is also a new configuration
utility that guides you through the configuration process.
Specify your own JES console character - it is now possible to configure the Mainframe Access
installation to use a different JES console character instead of the default ("$"). To achieve this, use the
new JES_CONCHAR configuration parameter.

Enhancements are available in the following areas:
Managed COBOL
Back to Top
Deploying JVM COBOL to an Application Server:
•

8
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Running JVM COBOL under WebSphere 9.0 and WebLogic 12.2.1 is now supported.

OpenESQL
Back to Top
This release provides the following new features:
•
•
•
•
•

Support for SQL Server 2017.
The SQL(TRANSACTION) compiler directive has been enhanced to clearly define transaction
boundaries.
A new SQL(NOWHERECURRENT) compiler directive that allows you to define updateable cursors that
do not do positioned updates or deletes with PostgreSQL or MySQL.
Larger communication area (PID) that accommodates longer plan and program names.
SQL(OPTIMIZECURSORS) has been enhanced for consistent and better cursor performance across all
OpenESQL backends.

Platform support
Back to Top
Note the following changes in platform support for this release:
•

Windows 8 and Windows Server 2012 are no longer supported for developing applications. They are
still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are supported.

What's New
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.
Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Application Server JCA Support
CICS Support
Code Coverage
Codeset Support
Common Communications Interface
Communications Server
Data Tools
Documentation
Enterprise Server
Enterprise Server Auditing
File Handling
HCO for Microsoft SQL Server
JCL Support
Mainframe Access
MF Server Administrator (GUI)
Micro Focus Directory Server
Run-Time System

Application Server JCA Support for Enterprise Server
•

With this release, all CICS-related Java artifacts have been delivered using a new directory structure
under the javaee-ccl directory of your Enterprise Test Server installation directory. The javaee-ccl
directory structure mimics the structure of the javaee directory. For example, mfccl.jar is no longer
located in the bin subdirectory, but can be found in the javaee-ccl\common directory.

CICS Support
Back to the list
•

Client ECI timeouts now propagate CTG requests to ABEND AITH the ECI server program.

•

The update resource definition file utility, CASRDTUP, now supports the DELETE command. Note that
the REMOVE option is not currently supported.
2885020 (1108004)

Code Coverage
Back to the list
•

10

Schema changes that affect the test coverage results generated from the tcutil utility mean that if
you propagate the results to a third-party application (for example, an XSLT processor), and rely on the
<copyFileCoverage> element, you need to alter your transformations to focus on
<sourceFileCoverage> instead. The element was renamed to more appropriately reflect its
contents, as tcutil now gives global coverage for all source files (not just copybooks).
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Codeset Support
Back to the list
•

•

Code-set mappings between ASCII and EBCDIC have been updated when Simplified Chinese is the
language in effect. ASCII table 5210 now maps to EBCDIC CCSID 836 for SBCS conversions. This
replaces the previously conversion (where ASCII table 1042 was used), which would convert the “\”
character to “$”.
3124321 (1111464)
New single-byte character set tables for MFCODESET have been added in order to improve support for
DB2 LUW - both for off-mainframe databases and for access to z/OS DB2. A number of existing
MFCODESET mappings have also been updated. See 'Supported Country Codes' for a full listing of
ASCII/ANSI <-> EBCDIC mappings.
3111843 (1109984)

Common Communications Interface
Back to the list
•

You can now configure the Micro Focus Directory Server and enterprise server region’s listeners to only
use the server's configured SSL and TLS protocols and define a priority ordered cipher suite collection.
This forces connecting clients to use the server’s preferred ordered list of cipher suites when using the
specified protocols.
2866265 (1105526)

•

•

In some circumstances it was possible for a connection to incorrectly accept the identity of an SSL/TLS
peer and allow a connection to complete when the connection should have been denied. This occurred
due to a failure to check the peer's entire identity certificate chain. This has now been fixed. NOTE: You
might need to correct your system’s configured certificate chains that fail verification checks at secure
connection creation time.
In some circumstances it was possible to crash the CCITCP module when it was attempting to obtain
detailed error information about a closed connection. This has been fixed.

Communications Server
Back to the list
•

•
•

TN3270 conversations to Enterprise Server now correctly handle the receive (idle) timeout setting
configured for the listener. There are also two new settings for configuring TN3270 timeouts, "Printers
time out" and "Output resets timeout". See the online product documentation for more information.
3144133 (1113024)
MFCS listeners can now be SSL-enabled without the need to have DemoCA installed.
2868627 (1105777)
MFCS no longer initializes the Security Facility if there are no External Security Managers defined for
the region.

Data Tools
Back to the list
•

Records with an invalid value for a conditional field will no longer result in a match for that conditional
layout.
2853226 (1103406)

Documentation
Back to the list

Significant Changes in Behavior or Usage
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•

•

You can use 'byte' or 'BYTE' as a synonym for the binary-char unsigned data type. As a result, 'byte'
and 'BYTE' are now reserved words in Managed COBOL. Use the REMOVE"BYTE" Compiler directive
to prevent an error being produced for existing programs that use the reserved word as a user-defined
word.
3147576 (1113323)
As of version 3.0, references to types within an assembly other than mscorlib need to be explicitly
referenced. You can achieve this by using the ILREF Compiler directive. (Previously, in certain
circumstances, the Compiler would allow access to types within the System.dll assembly without the
need for an ILREF"System" directive.
3121002 (1111373)

Enterprise Server
Back to the list
•

•

•

•

The External Security Facility (ESF) can now be configured to throttle large volumes of incoming Verify
(user authentication / signon) requests to improve resilience to denial-of-service and brute force attacks.
See "Verify Request Throttling" for more information.
3113639 (1110160)
The LDIF files used to create the sample configuration for Enterprise Server LDAP-based security no
longer create an empty "PHYSFILE" resource class. Changes in the JCL engine as of ES 3.0 caused
most jobs to fail when submitted to a security-enabled region using such a configuration. See the
product help for more information.
The MLDAP ESM Module, part of the Enterprise Server External Security Facility, now supports the
Argon2 hash algorithm for creating password verifiers. See MLDAP ESM Module Custom Configuration
Information in the product help for more information. NOTE: The Argon2 hash is optional and not
enabled by default.
The MQ pages in ESMAC are now controlled by a new security resource, MQL. This enables you to
either restrict or grant users access. 'MQL*' is a new resource that needs to be added under MFESMAC
similar to existing resources such as 'PCT*' or 'XAT*'. The following is a sample export of the LDAP
repository:
******************************
# Sample security definitions for ESMAC MQ Listeners/Writers pages
#######################
###### MQL*
##
#######################
dn: CN=MQL*,CN=MFESMAC,CN=Enterprise Server Resources,CN=Micro
Focus,CN=Program Data,DC=X
changetype: add
cn: MQL*
objectClass: microfocus-MFDS-Resource
microfocus-MFDS-Resource-Class: MFESMAC
microfocus-MFDS-Resource-ACE: allow:SYSADM group:alter
microfocus-MFDS-Resource-ACE: deny:*:execute
microfocus-MFDS-UID: mfuid
#description: Allow full access any ESMAC MQ Listeners/Writers Screen
******************************

•

•
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3143258 (1112990)
You can now use the ECIResponse.getReturnCode() method to obtain the return code for any errors
from Enterprise Server.
3142092 (1113248)
Communication with the console daemon has been improved. Messages are displayed more quickly
and requests are being processed more efficiently and, as a result, times for initialization and shutdown
might be reduced.
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•

3136867 (1112483)
Administrators can now add, delete or modify XA resources in the Enterprise Server Administration
Web UI while a region is running.
2589624 (1085625)

•

CICS Web services has been updated to include the ES_TRANCLASS_CWI environment variable,
which enables you to prioritize and limit Web requests in a TRANCLASS-enabled region. When the
ES_TRANCLASS_CWI environment variable has been set to either TCPIPSERVICE (default) or
URIMAP, a TRANCLASS-enabled region processes the elected transaction according to its priority and
associated TRANCLASS.
Note: When using CICS® Transaction Server for z/OS®, Version 3 Release 1, and IBM CICS
initiates the ATTACH transaction followed by the ALIAS transaction for a single Web request, this is
intended to enable the application of different limitations and priorities on these transactions.
Enterprise Server does not support this. Instead, a TRANCLASS-enabled region processes the
requests as a single ATTACH transaction, and uses the ALIAS transaction for security checks.

•

3126381 (1111349)
Web access to the Enterprise Server Console Log and Communications Server Log is now restricted
when the enterprise server region is secured using external security. Users will be required to provide a
valid username and password in order to view either log file.
Web access to the logs can be controlled using the standard ACL definitions under the new
Communications Server resource class, with resources Enterprise Server Console Log and
Communications Server Log. If these resources exist, users require 'read' access to be allowed to
view the logs. If the resources do not exist, the default behavior is to allow 'read' access on entry of a
valid username and password.
An example of the new resource class and resource definitions can be found in the
es_default_ldap_msuser.ldf file, which is located in the bin sub-directory of your product
directory.

Enterprise Server Auditing
Back to the list
•

•

The maxRetryTime value in the audit configuration file now treats 0 as a no timeout time, and any
negative number as an infinite timeout.
3150566 (1113592)
Any extra information that was added to the syslog messages will now correctly appear in the structured
data items.

File Handling
Back to the list
•

•

In some cases the ESF LDAP Security Administration Web Interface inadvertently removed users from
groups when changing their password. This has been fixed.
3124294 (1111259)
The ESF LDAP Security Administration Web Interface can now filter by Class and Resource name,
description, and ACL. Previously, you could only filter on Class name.
2871549 (1106119)

•

For .NET applications, set XFHLOG=DEFAULT to create the XFHLOG file in the current directory;
otherwise it is created in C:\ProgramData\Micro Focus\[ED/VS]\[Release]. From release 4.0 onwards,
this variable also has an effect for native applications.
3115116 (1110323)
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•

Setting the configuration option ASCIISOSI=ON will adds the required SOSI characters to the relevant
EBCDIC DBCS character strings, in order for them to be displayed or written out correctly.

•

3113802 (1110183)
The OPEN mode of SYSOUT files now honors the DISP specified in the JCL.

•

3109432 (1109745)
OPEN I-O of a virgin ESDS file now correctly returns a file status of 35, as it does on the mainframe.
2887724 (1108443)

•

The TO parameter is now supported for TOT|TOTAL, MIN, MAX, and AVG in the TRAILER3 trailer item.

•

3135298 (1112194)
The OUTFIL statement of a SORT operation now supports the NULLOFL parameter.

•

3110364 (1109822)
The MFJSORT OUTFIL emulation now supports the VLTRIM parameter.
3107105 (1109820)

HCO for Microsoft SQL Server
Back to the list
•

•

The HCOSS Manage Connections tool was incorrectly limited to using the default CCSID for mainframe
DB2 connections, causing problems when mainframe database did not use the default CCSID of 37.
This has been corrected by the addition of a text box that enables the setting of a specific CCSID value
for the connection.
3130137 (1112180)
When using the DIALECT=MAINFRAME setting, the OpenESQL STRICTPARSE SQL compiler
directive option is now turned on by default for ODBC (DBMAN=ODBC). This ensures strict compliance
with z/OS DB2 syntax.
If your applications require the OpenESQL preprocessor to behave as it did in an earlier release,
compile using NOSTRICTPARSE.

JCL Support
Back to the list
•

•

•

•
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You can now configure MFFTP to not process trailing blank spaces for a GET command, by setting the
new control variable MFFTP_PROCESS_TRAILS_ONGET=FALSE and setting the LOCSTAT value
TRAILINGBLANKS=FALSE.
3138375 (1112486)
ICEGENER now does not copy the RECFM from SYSUT1 to SYSUT2 if SYSUT2 RECFM is not
specified in JCL and when SYSUT1 is VSAM. It defaults to F/FB if SYSUT2 is non-VSAM, or V/VB if
SYSUT2 is VSAM.
3131268 (1111805)
An error in identifying the IDENT in IEBGENER when the record included high values at the start of the
record has been corrected.
3109443 (1109759)
FOR ED 2.3.2 HF7: The following changes have been made to the MF_UCC11 environment variable:
MF_UCC11=Y - when running a job with DISP=(NEW,CATLG), it will not result in job failure caused by
the data set already being cataloged. MF_UCC11=YR - when restarting a job with
DISP=(NEW,CATLG), it will not result in job failure caused by the data set already being cataloged. For
ED 3.0 HF1: The following changes have been made to the MF_UCC11 environment variable: The
default behavior of MF_UCC11=Y has changed: DISP=NEW is changed to DISP=MOD only when the
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job is restarted. MF_UCC11=YA reverts to the old behavior of changing DISP=NEW to DISP=MOD
even when the job is first run.
•

•

3107409 (1109722)
The introduction of a new environment variable, ES_OLD_DYN_PDS, has changed the resulting
behavior of dynamic PDS members when specified in a JCL DD statement. Default behavior
(ES_OLD_DYN_PDS=N) no longer creates physical files or catalogs the PDS members when specified
in a JCL DD statement. Set this variable to Y to enable the previous default behavior of creating the
physical files and cataloging PDS members when specified in a JCL DD statement.
2845176 (1102528)
To prevent unintended deletion of a GDG Bias, a GDG in use by one job may not be accessed by a
second job until the first job has completed.
2816745 (1101569)

Mainframe Access
Back to the list
•

Calling mfmon2.exe with the following options has the given effect:
1. If you do not specify "EXTENSION" or specify "EXTENSION=" it will result in files downloaded
without an extension.
2. If you specify "EXTENSION=*" you will get an extension that matches the last part of the data set
name. For example, if the source data set is a.b.c.d then the file extension will be .d.
3. Everything else results in the extension specified. For example, "EXTENSION=txt" will result in files
downloaded with a .txt extension.

MF Server Administrator (GUI)
Back to the list
•

The total number of active sessions or clients in MFDS is now limited to 2000.

Micro Focus Directory Server
Back to the list
•

The mfds -g options D, O, and S have been added to the product Help.

•

2848627 (1102864)
MFDS now disables and limits the scope of Web listeners on add. It also emits a warning if any
insecure Web listeners are displayed in the validate and listener tables.

Run-Time System
Back to the list
•

The run-time system now produces a more precise error message if a shared object of the wrong bitism
is loaded.

Significant Changes in Behavior or Usage
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.
In addition, note the following:
•
•
•
•
•

CICS
Commuter licenses
Enterprise Server
Installation
OpenSSL

CICS
EXEC CICS VERIFY PASSWORD has a failure scenario that doesn't exist on the mainframe. It is currently
not possible to distinguish this failure from an incorrect password on the command itself via the returned
EIBRESP and EIBRESP2.
Under Enterprise Server, the following options mean that an admin LIST request to ESF is necessary to
acquire the appropriate information:
CHANGETIME
DAYSLEFT
EXPIRYTIME
INVALIDCOUNT
LASTUSETIME
If no users are signed on to CICS, then this admin request will be made as the default CICSUSER which
will be rejected.
The VERIFY PASSWORD command will return NOTAUTH 2, "The supplied password is wrong".
This is misleading because it implies that the value for PASSWORD on the command itself is incorrect.
Note that in that case, CICS returns NOTAUTH 2 as per the mainframe.
The aggregated return code from ESF to CICS for the admin request is identical in both cases and so
CICS has no way of distinguishing between these two failure scenarios. We therefore cannot return a new
EIBRESP or EIBRESP2 for this particular case.
To allow CICSUSER to make admin LIST requests, the anonymous list option needs to be enable in the
region's security manager configuration (not the Security Manager):
[Admin]
allow-list=yes
Commuter licenses
If there are a number of entries displayed in the License Administration tool, these might be either for
different products or for the same product but for different serial numbers, for example.
When a commute request is made using the license manager, that request is serviced from a pool of
licenses that could be provided by any number of Micro Focus product licenses stored on that server. The
commute request cannot target a particular RMS license by product name, serial number, or number of
cores.
The products to which you apply the commuter licenses will be licensed correctly but the number of
licenses left in the License Administration tool might appear to be less than expected. This issue is more
likely to occur with multiple entries for the same product.

16
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If you are using a number of different products, Micro Focus recommends that you use a different licensing
server for each product in order to help minimize the issue.
Enterprise Server
•

On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server
Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

Installation
•

Installing this product fails if Micro Focus License Manager version 10000.2.02070 (April 2015) or older
is already installed on your machine. The setup files does not upgrade the License Manager
automatically to the latest version. You must uninstall the existing version before you start the
installation.

OpenSSL
The version of OpenSSL included in Enterprise Developer and Enterprise Developer 4.0 is intolerant of
expired X.509 certificates in the CA Root Certificate collection in some circumstances. Specifically, if you
configure a PEM file that contains multiple certificates as the collection of trusted CA certificates, and one
or more of the certificates in that file have expired, OpenSSL might not be able to load and use other
certificates in the file which are still valid. This can cause certificate validation errors and connection
failures for SSL and TLS connections.
To work around this, you need to remove any expired certificates from such collections. If necessary,
replaced them with any valid certificates that have the same Distinguished Name and Modulus (key). This
is a known issue with OpenSSL. Micro Focus is investigating for other possible workarounds.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Adis
Assembler Support
CICS Support
COBSQL
Codeset Support
Common Communications Interface
Data Tools
Documentation
EJB Generation
Enterprise Server
File Handling
IBM Language Environment for OS/390 & VM Support
IMS Support
Interface Mapping Toolkit
J2EE Connector
Java Support for COBOL
JCL Support
MF Common Client
MF Communications Server
Micro Focus Directory Server
Mainframe Access
Micro Focus Batch Scheduler Integration
Micro Focus Cryptographic Library
Monitoring and Management
OLE Class Library
OO Base Class Library
Run-Time System
Setup Issues
HCO for DB2 LUW
SQL: HCO for SQL Server
SQL: MBDT Utilities
SQL: OpenESQL
SQL Option for DB2
XML Support

Adis
Back to the list
•

When running under DIALECT"RM", a DISPLAY statement using the WINDOW-CREATE clause will
create a window. Its position can be relative to the parent window or the screen. The position specified
will be the upper-left position of the first character in the window. If the window has a border specified,
the border will not change the location of the first character on the window.
3143230 (1112975)
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•

•

By default, the ZERO-FILL SCREEN SECTION clause only affects alphanumeric items when the data is
modified in an ACCEPT statement. For compatibility with ACUCOBOL-GT, Adis includes a new
selection (#3) to the option '16 Force Field to be updated if it is not altered'; it reads: 3: Alphanumeric
fields with the ZERO-FILL clause are updated even if the field is not altered.
3137641 (1112412)
JUST (and RIGHT-JUSTIFY) now works when specified in the data item for a CONTROL clause.

•

3137065 (1112350)
Internal limits that would cause a 'COBCH1990-S Internal error - Code generation of SCREEN
SECTION exceeded 65535 bytes for large SCREEN SECTION' message have been removed.

•

3130462 (1112572)
Box line characters no longer disappear when using DISPLAY WINDOW BOXED and the background
contains DBCS characters.

•
•

•

•

3125337 (1111261)
The window1 preprocessor now correctly handles underscores specified as part of a data item.
3123437 (1111084)
When using the Window1 preprocessor to support DISPLAY WINDOW ACUCOBOL-GT syntax, Keisen
and reverse-video attributes are now supported. Note: Due to the way that the attribute system works
on a Japanese OS, to make space for Keisen attributes, background-color attributes are not supported.
3123217 (1111064)
To emulate RM/COBOL behavior, an additional action affecting the left- and right-cursor keys within a
field has been added to ADISCTRL. Setting 25 contains a new action (value #3) that emulates the
behavior of generating an exception when trying to move beyond the left- or right-hand edge of an entry
field. However, unlike RM/COBOL, where you can control the exception generation of the left and right
cursor keys individually and specify the exception values generated, this action affects both keys, and
the values generated are fixed. They are 3 for the left arrow key, and 4 for right arrow key.
3115797 (1110548)
The PROMPT identifier in a SCREEN SECTION now works as expected.
3115743 (1110380)

Assembler Support
Back to the list
•

A problem that prevented the assembler from accepting omitted length parameters in instruction
operands has been fixed to match IBM HLASM behavior. For example, instructions of the form: PACK
AVAR(0),(,0) no longer generate assembly time invalid length errors.
3148361 (1113412)

•

To enable all DC C'...' variables to be defined using ASCII instead of EBCDIC characters, the ASCII
Assembler directive has been added. To use this directive, enter: RUN MF370CHK <filename.mlc>
ASCII Note: This affects C'...' items only. For example, EBCDIC characters defined using DC X'F1' are
not affected. In addition, use of the ASCII directive could cause application logic to fail if the application
assumes character data is in EBCDIC collating sequence order.
3114383 (1110222)

•

The EIBLENG symbol has been added to the Assembler file DFHEIBLK.MAC for compatibility with the
mainframe.

CICS Support
Back to the list

Resolved Issues
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•

Using read-only MAP files resulted in an ABEND APCT.

•

3110551 (1109925)
The OUTDESCR option for EXEC CICS SPOOLOPEN OUTPUT is now supported. The output
parameters specified using this option are available to your user printer exits.

•

3107410 (1109522)
A background task issuing an EXEC CICS START transaction with data sometimes resulted in errors
when dispatching the transactions. This has been fixed.

•

3104918 (1109663)
Running concurrent browse INQUIRE TERMINAL on a busy system sometimes caused an RTS 114
error in dfheserv and/or sometimes caused communication server failure. This is now fixed.

•
•

3103089 (1109282)
EIBCALEN was re-initialized incorrectly on return from a called program.
2862990 (1104824)
This release provides support for IBM's AUTORESETTIME option in the SIT configuration. You can
specify your preferences for AUTORESETTIME in ESMAC under Resources > by Group and by setting
a "Reset time" option in any SIT configuration. The supported options are:
•
•

•

Immediate - The system detects a timezone (date) change at any time. It then changes the clock in
the region on the next transaction which is started.
No - The system detects a timezone change at midnight and writes a notification in the console.log.
You then need to run a transaction that will issue the PERFORM RESETTIME for the time to be
changed.
Yes - The system detects a timezone change at midnight and automatically resets the clock.

•

2858836 (1104325)
When a file is defined in CICS as catalogued, Enterprise Server now displays the type as (CATLG) in
the ESMAC/ACTIVE/FCT instead of KSDS or ESDS.

•

2846390 (1102866)
An enterprise server region could crash if the transaction CDBG was executed and no debugger was
attached.

•

2828665 (1100470)
The QUEUE disposition for an extra-partition is now honored on open.
2638481 (1088593)
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•

casrdo52 no longer crashes intermittently.

•

2841426 (1102352)
The T-Type page in ESMAC has been fixed.

•

2832495 (1100861)
The maximum value for ES_ESMAC_DISP_MAX_OVERRIDE has been changed to 99999.

•

2832069 (1100820)
When browsing the contents of a file in the ESMAC catalog page, the back arrow button, "<", now
navigates to the previous page instead of to an empty list of files.

•

2822494 (1099670)
The TS/TD warm/cold start flag state in SIT was only checked for TRANCLASS. It is now always
checked.

•

2676393 (1092162)
Memory validation on entry or exit of programs can now be set dynamically from the Control page in
ESMAC.

| Resolved Issues

•

The CFLE /K option now works correctly.

•

2860360 (1104438)
The refresh rate for displaying the search records has been updated and the search algorithm is now
faster.
2856608 (1104800)

•

•

•

Any special characters for Transaction used in DEFINE TRANSACTION are now imported correctly and
will be displayed in ESMAC.
2886545 (1108211)
When creating a new SYSC resource in ESMAC, Enterprise Server now performs a validation and
returns an error if you specify any invalid parameters.
2881865 (1107538)
When defining a TDQUEUE, a value of 0 for RECORDSIZE is now accepted.
2807605 (1097659)

COBSQL
Back to the list
•

A problem that caused COBSQL to mishandle EBCDIC conversion when the program was called more
than once has been fixed.

•

3145943 (1113226)
A problem that caused incorrect indentations in generated code when using the KEEPCOMP directive
has been fixed.

•

3144736 (1113124)
A problem with COBSQL handling of spaces between the colon and the host variable name has been
fixed.

•

3144632 (1113283)
A problem with COBSQL incorrectly handling the AMODE directive has been fixed.

•

3144632 (1113257)
COBSQL now correctly handles host variables with the same name that are defined in different groups.

•

3139017 (1112553)
KEEPCOMP will now check SQLCODE for FETCH statements before performing a byte order swap on
COMP data items.

•

3138321 (1112476)
A problem with COBSQL correctly handling replaced lines greater than 72 characters in length has
been fixed.

•

3127369 (1111465)
COBSQL failed to recognize declared host variables that were identified using a two-part name. This
has been fixed.

•

3127102 (1111417)
A problem that caused the COBSQL preprocessor to incorrectly handle the WORKING-STORAGE
SECTION statement has been fixed.

•

3124957 (1111232)
An occasional problem with COBSQL reinitialization that caused the second background parse to fail
has been fixed.

•

3124170 (1111154)
The COBSQL preprocessor was not handling COPY... REPLACING... statements correctly, causing the
Debugger to display incorrect information. This has been fixed.

Resolved Issues
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•

3123903 (1111140)
A problem that caused COBSQL to fail to parse the PROCEDURE DIVISION statement correctly when
part of the statement was in a copybook has been fixed.

•

3122593 (1111019)
A problem that caused the COBSQL preprocessor to fail to generate HSF trace data When either the
EBCDIC or KEEPCOMP option was specified has been fixed.

•

3120860 (1110883)
A problem that prevented COBSQL from processing more than 150 lines of similar source code in a
single source file has been fixed.

•

3112520 (1110134)
A problem that caused the COBSQL preprocessor to incorrectly process child items when either the
KEEPCOMP or EBCDIC options were specified has been fixed.

•

3110932 (1110772)
A problem that prevented the COBSQL preprocessor to correctly process data groups when the
KEEPCOMP directive was specified has been fixed.

•

3110932 (1110575)
A problem that caused COBSQL to fail to recognize all data items correctly when the host variable was
a group item has been fixed.

•

3110932 (1110650)
A problem that prevented COBSQL from correctly recognizing the parents of some data items when the
KEEPCOMP directive was specified has been fixed.
3110932 (1110495)

Codeset Support
Back to the list
•

The current Shift-JIS EBCDIC to ASCII support under MFCODESET=81,930,939, and 9122 is based
on the Japanese International Standard (JIS) X 0208 1978 revision. New conversion tables have been
added based on the JIS X 0208 1990 revision - the tables have been taken from IBM's Conversion
Tables CCSID 300 - 941. To use these new conversions instead of the default ones, set
MFCODESET_DBCS=941.
3143604 (1112980)

Common Communications Interface
Back to the list
•

An intermittent failure to establish a TCP connection with various components (including CCITCP,
COBOL service deployment, and JCL job submission) was caused by the EADDRINUSE error. This has
been fixed.
3123202 (1111222)

Data Tools
Back to the list
•

The /d parameter of the DFSTRCL command line utility is no longer case sensitive.
2989512 (1108654)

•

Applying a filter to a data file after selecting a field no longer causes the editor to crash.
3139552 (1112637)
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•
•

•

Large structure files can now be loaded within the editor.
3122802 (1111101)
When performing a filter more than once, the filter no longer encounters a 9/41 corrupt indexed file, and
the correct navigation buttons are enabled. Additionally, the filter now shows the correct number of
filtered records.
2883777 (1110293)
The Data File editor now enables you to export filtered results to a new data file: option Search>Export
Results when a filter is in effect.
2878521 (1107103)

•
•

DFCONV now shows its version number, rather than "TEST", when used from the command line.
3114824 (1110281)
Classic Data File Tools now supports IDXFORMAT(12). You can create files of this format, and use the
Data File Convert tool and DFCONV command line utility (including .pro files) to convert to and from
this format.
3113772 (1110180)

Documentation
Back to the list
•

•

•

•

•

The documentation now states that the ILSMARTLINKAGE directive is only for use with procedural
COBOL programs, not COBOL classes.
3147500 (1113420)
The product help now clarifies that cblcored.exe requires write permission to the current user’s
HKEY_CURRENT_USER key in the Windows registry. This ensures that any changes to the Core
Dump settings made with the utility will persist.
3142772 (1112972)
The IMS Tracing Flags topic has been updated to accurately reflect the options available in Enterprise
Server.
3142342 (1113320)
An important distinction has been made in the documentation, in that the content of nonnumeric literals,
comment lines, comment entries and data can include any of the 'printable' characters available in the
current character encoding scheme. See the 'Character Set' topic of the Language Reference Manual
for more information.
3140851 (1112720)
The 'Standard File Header' topic now states that the definition is not applicable to certain indexed file
formats. The definition of the node sizes, as specified in the 'Index File - File Header' topic, has also
been clarified so that it applies to all applicable MF index file formats.

•

3140352 (1112840)
The ACCEPT statement documentation now contains the possible values codes/definitions returned for
EXCEPTION STATUS.

•

3138691 (1112556)
The documentation now documents the difference between MF COBOL and RM/COBOL when
inspecting the EXCEPTION STATUS in an ACCEPT statement.

•

3138691 (1112555)
Documentation for the SPZERO Compiler directive now directs you towards the preferred replacement,
SIGN-FIXUP.
3135675 (1112227)
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•

•

3132391 (1111933)
The use of the INTLEVEL Compiler directive has been clarified in the documentation; that is, it is an
internal directive, not intended for customer use.

•

3129661 (1112191)
If mnemonic-name is associated with ENVIRONMENT-NAME in an ACCEPT or DISPLAY statement, its
value must not exceed 255 bytes.

•

3126506 (1111354)
A restriction has been documented for the X"B0" Function 2 library routine, where console applications
cannot distinguish between the left and right Shift key presses.

•

3125717 (1111316)
The sample code listed within the documentation topics 'Customizing an STC scheduler address space
JCL' and 'Customizing a user server address space JCL' has been corrected to include missing syntax.

•

3124411 (1113586)
The documented example for OO switches has been updated to remove an obsolete switch.

•

3117356 (1110506)
A new syntax rule (#9) has been added to the CALL statement topic in the Language Reference
Manual, stating the restriction of passing a floating point item BY VALUE in native COBOL.

•

3115091 (1110326)
The documentation for the BELL directive has been corrected to state that it is checked during the
syntax checking phase, and not at the generate phase.

•

3110088 (1109799)
In the documentation, the steps required to customize ASCII\EBCDIC character set conversion have
been clarified.

•

3108884 (1109682)
More information has been added for file and project level problem error markers. See Maximum
Number of Problem Error Markers for more information.

•

2881233 (1107671)
An error has been corrected in the description of the "Go To Procedure Division" option in the "Making
the Most Out of The COBOL Editor" topic.

•

2877216 (1106910)
Documentation for 'COBRT181 Invalid parameter error' has been expanded to include a possible cause
and solution for the error.

•

2876095 (1106782)
The instructions on how to install Fileshare as a Windows service have been clarified - see
'Walkthrough - Fileshare as a Service' in the product docs.

•

2876085 (1106746)
The product help now clarifies that adding the Micro Focus Runtime (Interop RuntimeServices)
assembly adds the MicroFocus.COBOL.RuntimeServices reference to a Visual Studio project.

•

•
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The order in which the File Handler searches for the File Handling configuration file has been correctly
documented for UNIX and Windows platforms.

| Resolved Issues

2850791 (1103124)
The Sharing Database Connections Between Java and COBOL topic has been updated with an
example showing object sharing with other languages both when Java opens the connection and when
COBOL opens the connection.
2674454 (1091949)
The ANSI92ENTRY topic has been updated to include OpenESQL behavior in corfomance with the
ANSI-92 standard.

•
•

2596163 (1086171)
The SQLCODE Values topic has been updated to reflect the most current information available.
2593799 (1085947)
The CALL-RECOVERY documentation topic has been amended for clarity. The syntax and behavior is
unchanged. When a CICS transaction has installed an ABEND handler at a given link level, if an
ABEND occurs lower down the call chain where non-CICS programs have been called between the
owner of the handler and the abending program, the CALL-RECOVERY directive ensures that control is
passed directly back to the higher level without executing application code after the call(s) in the
intervening programs. Parameters <integer> - Must be one of:
1. Makes the program check the current call recovery state every time control is returned to it following
a call. If there is a controlled exit in force the program performs a GOBACK, that is, passes control
back up the COBOL call chain rather than continuing with the next statement
2. As for 1, but also catches exceptions on CALL dataname statements and sets the call recovery state
before performing a GOBACK to pass control back up the COBOL call chain.

•
•
•
•
•

•

•

•
•

•

•

•

Note: You should use CALL-RECOVERY when compiling a mixture of CICS and non-CICS programs for
running in Mainframe Subsystem Support. Only the non-CICS modules need be compiled with the
appropriate directive. When compiling only CICS programs, CALL-RECOVERY is not required.
The error message description for COBCH1558 has been expanded to include the possible scenario of
when a difference in bitism (between Java version and compilation mode) has caused the error.
The COBCH1006 error message text has been corrected to encompass the fact that different dialects
have different limits for the length of a COBOL word.
The documentation has been corrected to state that the LINKLIB directive is not required by the cobol
command. (LINKLIB was an old directive that should no longer be used.)
The Codecomp Utility documentation now states that you can only create customized tables for singlebyte character sets.
An incorrect reference to SYSREC has been removed from the example in the topic "SQLTP2 Utility Executing Dynamic SQL Statements".
3145877 (1113167)
When using the MVSSPLHK spool housekeeping process to override the retain period of a class; for
example: CLASS A 003 Y this refers to the output dataset class, and not the job class.
3138584 (1112576)
The instructions on running the SPOOL conversion tool (splconv) have been updated with
recommendations for setting the MFSYSCAT_ERRS variable. This is because there are a number of
errors generated whilst running the conversion that can be safely ignored, and setting this variable to a
sufficient value will allow the conversion to complete successfully.
3124350 (1111280)
Documentation for MFJSABCODE has been added to the Sort environment variables.
The product help now includes details about the CESL CICS supplied transaction. CDEQ, CZTD and
CZTS are only internal and not directly executable.
3153520 (1113840)
When running the dfconv command line utility, the (optional) -d option must be the first parameter
specified in order to have an effect.
3135598 (1112570)
The product help about "Datetime Literals in SQL Statements" now correctly states that to enable the
functionality, you need to code any of the specified SQL comments into your DB2 mainframe
application, positioned before a literal declaration.
3133502 (1112053)
Where appropriate, the SYNCSORT and DFSORT documentation now links directly to the topic that
explains the various field types in use.
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•

3123796 (1111143)
Error message BMSCH1099W has been documented.

•

3122477 (1111005)
Details for error BMSCH1083W have been added to the documentation.

•

3122476 (1111004)
The topic that lists the Compiler directives restricted in Managed COBOL has been brought up to date.

•

3120358 (1110789)
To enable Language Environment (LE) support for all applications (other than JCL) running in
Enterprise Server, set the environment variable ES_LE370_SUPPORT=Y

•

3118312 (1110678)
Documentation now includes JCL event information for the 'event-job-stmt-info' and 'event-uxit-changedjob-name' events.

•

2990395 (1108725)
Information on the TCLS Entity has been added to the product documentation. See Resource Classes
for ESMAC and Operator Command Security for more information.

•

2913474 (1108497)
The documentation now references the es_default_ldap.ldf file, which contains a working example for
using the DATASET resource class.

•

2860914 (1104513)
The documentation has been updated to explain how best to configure CICS for use with WebSphere
MQ.
2817494 (1099421)

EJB Generation
Back to the list
•

A problem that caused EJB client generation to fail when processing OCCURS arrays has been fixed.
3131411 (1111877)

Enterprise Server
Back to the list
•
•
•

Starting the MFDS process with the -r option will now disable the Web administration UI. If using a
browser to connect to the MFDS TCP network address, you now receive an HTTP 403 response.
A missing form name in some Enterprise Server Administration pages could result in a JavaScript error.
The default options under ESMAC > Resources now depend on the Region options. If JES is installed,
the new default resource to show under Resources is JES. If IMS is installed, and JES is not installed,
then IMS is the default. If MQ is installed, and both JES and IMS are not installed, then MQ is the
default. If iFS is installed, and each of JES, IMS, and MQ are not installed, then iFS is the default.
Otherwise, the default resource is Services.
2871166 (1106098)

•
•

An issue using single sign-on between MFDS and ESMAC has now been fixed.
3106232 (1109779)
The Enterprise Server External Security Facility (ESF) has improved redundant / failover support for
Security Managers. See "Security Configuration Custom Configuration Information" in the product help
for more information.
2990790 (1109080)
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•

•

•

•

•

•

The Enterprise Server External Security Facility's MLDAP ESM Module can now generate an audit
event describing the "effective rule" that determined the decision (allow / deny / permissions set) for an
Auth or XAuth request. The effective rule is the security rule that was used to make the decision. See
“MLDAP ESM Module Custom Configuration Information” in the product documentation for more
information.
2887945 (1110096)
Enterprise Server Security trace message 2003, emitted when a SAFROUTE(Auth) request is made
with the "API trace" flag enabled and access to the resource is denied, no longer truncates long
resource names. Long names are abbreviated but still provide the prefix and suffix of the name.
2885856 (1108682)
Enterprise Server's External Security Facility, when using LDAP-based security, has an "Update"
mechanism that can be used to notify MFDS and running Enterprise Server regions of changes to
security information. This now works correctly for changes to group membership, for example, when a
user is removed from a group.
2873024 (1106452)
Depending on the sequence of login, users with long usernames that contained spaces and that had
usernames similar to other users could login and find that they are treated as if they do not have the
correct user permissions. This has now been fixed.
In Enterprise Server, when using LDAP-based security, if a user belonged to a group with an LDAP
wildcard character (such as "*") in its name, and there were nested groups defined, and the use-allgroups mode was enabled, groups that contain other groups could be incorrectly added to the user's
group set. This has been fixed.
mfds and casstart will now run successfully on machines with locale names with the @modifier part,
such as fr_FR.iso885915@euro.
2868439 (1105641)

•

•

A CICS JSON RESTful provider that was invoked with an HTTP GET and subsequently executed an
INVOKE SERVICE would fail to map its response data to JSON.
3151018 (1113677)
Previously, a CICS Web Service requester application would receive INVREQ 13 on an INVOKE
SERVICE if it had been initiated via HTTP with a method other than POST.

•

3151018 (1113623)
Extended ECI LUW context is now maintained.

•

3148577 (1113418)
Using the dump command from an MQ listener resulted in an AB/BA lock.

•

•
•

•
•

3146317 (1113217)
In 64-bit environments, ECI requests that do not use ES_ECI_SOCKET to identify or locate the target
region used to fail.
3143232 (1112962)
Receiving an IMSConnect request before CASTMC had fully started up could result in a trap in casgate.
3142402 (1112977)
A request made with valid credentials no longer fails after an initial request that returned an error ECIERR-SECURITY-ERROR.
3142092 (1113220)
The Data File Editor now supports DSNs that contain the '£' and '#' characters.
3140182 (1112661)
You no longer receive a PGMIDERR error on the second invocation of a CICS program when using a
symbolic link (and the shared object name does not end in .so) and FORCE PROGRAM PHASEIN is
off.
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•
•

3135994 (1112257)
Previously, when creating a new DFHDRDAT, the provided users had an invalid phrase setup which
resulted in sign-on errors.

•

3135433 (1112238)
An "MVSJOBNO not found" error sometimes occurred when canceling a JCL job from the command
line. This has been fixed.

•

3134787 (1112325)
CICS Web services now provide basic JSON boolean support.

•

3134676 (1112143)
You no longer receive a JES000002E error in the ESMAC Admin SEP when submitting JCL after
viewing a previous job details.

•

3129388 (1112985)
When a job that performs an EXCI LINK without the SYNCONRETURN option was submitted twice in
succession, the second job did not run successfully.

•

3129348 (1111596)
An issue that could cause a memory corruption in CWS when application tracing was not ON has been
fixed.

•

•

•
•

•
•

•

•

•
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3139816 (1112624)
The casstop /w command no longer creates a ccierr.log when a region terminates during the /w delay.

| Resolved Issues

3127485 (1111431)
previously, HSF records for tasks that executed prior to a switch of the active file could be written to the
newly active file. This has been fixed so that records are written to the file that was active at the time the
task ran.
3125864 (1111322)
CICS now accepts JSONTRANSFRM and XMLTRANSFORM resource names of up to their maximum
lengths - 16 and 32 bytes, respectively. The previous limit was 15 bytes.
3123595 (1111110)
An issue with DFHJSON where JSON data would not be written to a container has been resolved.
3121607 (1110917)
The casutl command line utility supports a new option, /x, which enables you to switch the active trace,
dump and/or hsf files. For more details, see your product's documentation.
3120728 (1110848)
When recycling SEPs in a busy JES system, jobs that have not run yet are now managed correctly.
3120670 (1111235)
In a busy system, if JCL jobs timed out or were cancelled, the local trace entries could sometimes
corrupt the shared memory causing the region to become unresponsive.
3116835 (1110501)
You no longer receive an RTS 200 error message when a duplicate START of a transaction is presented
for execution at a target terminal which is busy. The duplicate AIDs are now discarded as under
mainframe CICS(tm).
3114982 (1110686)
Mapping structures to containers in DFHJSON when there are consecutive multiple empty elements
now works as expected.
3114815 (1110285)
If the result length from a call to CBL_CCSID_CONVERT was smaller than the original buffer length,
garbage was written at the end of the buffer. This was because the length used was the original length
and not the length returned from the call.

•

3114365 (1110223)
You no longer receive an error message when a single-byte EBCDIC character gets converted to a
double-byte UTF-8 character in CICS WEB SERVICES.

•

3112898 (1110070)
A FREEMAIN of a shared pointer which had been populated in a SEP other than the one attempting the
free would provoke a trap.

•

3112416 (1110196)
When either a CPMT NEW COPY is issued or FORCE PHASEIN is enabled on the SIT, MAPs are now
reloaded from the disk and the memory version will not be used.

•
•

•

3105813 (1109891)
The CICS internal reader under Tranclass could sometimes hang and stop processing work.
2988428 (1110144)
System folders that have a backslash at the end of the name are now supported in region
configurations. Previously, a region would fail to start in such scenarios.
2886956 (1108250)
The following issues with HSF have been resolved:
•
•
•

HSF records could be generated with a date prior to the date when the task actually started. This
could affect low-activity SEPs.
If a task ran over midnight then its response time would always be 1 centisecond regardless of how
long it ran for.
If a SEP was in the middle of either a CICS command, an EXEC SQL statement or a DLI call at
midnight, then the API, SQL or IMS field respectively would contain a high and incorrect value.

•

2870896 (1110045)
If there was an error when trying to start cobdebugremote, the port was not retrieved.

•

2864798 (1105495)
When defining a GDG model, the path is now grayed out.

•

2855374 (1103840)
It is now possible to use environment variables in MQ Listeners queue names.

•

2842137 (1102027)
If a casout -g command to retrieve relative DD for a job was issued and the resulting file had a size of 0,
the file was left open which resulted in a leak of handle.

•

2814439 (1098608)
Previously, Enterprise Server returned a mismatch error if you tried to add a new JES initiator from
MFDS when the region was already started.

•
•
•

•
•
•

2812102 (1098408)
An issue causing the BlueZone terminal emulator to disconnect has been resolved.
2807210 (1098676)
Requests are now aborted if the ECI luw token is invalid.
An issue with EXEC CICS SIGNON using PASSWORD in Enterprise Developer 3.0 could require an
application to have the PASSWORD variable used on the SIGNON command defined as PIC X(100)
rather than PIC X(8).
(1110862)
The "Use all groups" option for a secure enterprise server instance now enables the Data File Editor to
authenticate a user against all of the groups for a particular user.
Using casout with the /v option (to list initiators, printers and mprs) could cause incorrect HSF records to
be generated.
An issue where some HSF records for JCL steps could have incorrect response times and condition
codes has been resolved.
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•

It is now possible to edit the dataset name entry in ESMAC if an incorrect name was submitted when
adding the dataset.

•

A problem that caused a non-facility (file) DCT trigger to fail to reset the "triggered application active"
flag even when the queue had not been taken to QZERO has been fixed.

•

•
•

•

•

•

3147018 (1113307)
Documentation regarding support of the STATUS option on EXEC CICS INQUIRE PROGRAM and
EXEC CICS SET PROGRAM has been corrected.
3145947 (1113176)
EXEC CICS INQUIRE now correctly retrieves TSQs with names greater than eight characters.
3145414 (1113131)
A problem with SOAP message validation that caused an error on messages containing an ampersand
(&) character has been fixed.
3142837 (1112955)
An issue with WRITEQ TS REWRITE using an ITEM number greater that 32,767 with TRANCLASS
enabled now fails as expected. Enterprise Server no longer targets the wrong item returning an
EIBRESP of NORMAL.
3142092 (631187)
A problem with EXEC CICS VERIFY PASSWORD always authorizing against the default CICSUSER,
sometimes resulting in a failure when the default CICS user was different than the current CICS user,
has been fixed.
3141790 (1112971)
An incorrect response was being sent to the client when the default application handler was not used.

•

3141757 (1112838)
An issue with DFHFUNCTION prevented CICS Web services from returning a 16-byte space-filled field.
The DFHFUNCTION container now returns the value padded with spaces in a 16-byte field.

•

3141477 (1112779)
During a CICS DELAY, internal requests for file operations were not processed, sometimes causing
open/close file commands to hang. This is now fixed.

•

3132496 (1111945)
A problem with recovering a CICS region after terminating MFCS when CSKL was running has been
fixed.

•
•

•

3130515 (1111788)
Using CICS FREE CONVID with TRANCLASS no longer results in a SEP to be recycled.
3129235 (1111650)
In CICS regions in which all SEPs were busy, duplicate DTP requests for the same session were
chained, causing consecutive requests to hang. This has been fixed.
3126761 (1111397)
A problem that caused HSF records for transactions initiated via APPC to contain an incorrect response
time has been fixed to provide the correct response time. In addition, PCT counts for these transactions
have been updated.

•

3122337 (1111091)
A problem with the JSON CICS Web Services 'bottom up' demonstration application that appeared in
version 3.0, Patch Update 1 has been fixed.

•

3122046 (1110957)
The default transaction class 'DFHCTL00' is now returned when an INQUIRE transaction specifies the
option TRANCLASS and no TRANCLASS value was specified when the resource was installed.
3121827 (1110974)
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•

•

A problem that caused an ISC connection to occasionally automatically reconnect after it was released
from the active SysC page has been resolved.
3120128 (1110769)
Calling a PL/I program from ECI no longer results in a trap.

•

3119928 (1110753)
A problem that sometimes caused an ASRA abend after an EXEC CICS LOAD PROGRAM for PLI has
been fixed.

•

3119006 (1110649)
An incorrect MAPFAIL error was returned when a conversational transaction was executed with Force
Wait on Send in the SIT option. This has been fixed.

•

3113520 (1110251)
Making an EXCI call from batch to CICS which uses CICS Web Services no longer results in an error
RTS 173 on mF_ES_initialiseStack. Previously, casstack was being unloaded and is now built as a
system program.

•

3112236 (1110184)
A problem that sometimes caused EXEC CICS LOAD PROGRAM for a PLI program with
ES_FPPI_LOAD_SUPPORT enabled to fail has been fixed.

•
•

3112121 (1109994)
CICS Temporary Storage Queue expiry is now honored for systems that run with TRANCLASS enabled.
CICS APIs against type LOCAL Temporary Storage Queues now return values for LENGTH and
NUMITEMS.

•

Imported hexadecimal transactions are not truncated anymore.

•

3153155 (1113813)
Fixed an issue with the admin seps terminating abnormally when a USER (who is not associated with a
group in ESM) tries to logon to ESMAC.

•

•

•
•

•

3152197 (1113814)
Access to the XAT resources in ESMAC (casrdo65) is now controlled by the user's security settings for
the 'XAT*' resource under MFESMAC. The user will require "Update" access to the GRP resource in
order to see the XAT Delete button.
3143258 (1112991)
TCPIPSERVICE resources are no longer erased when the URIMAP resource is set to PIPELINE. In
addition, ESMAC now accepts blank WEBSERVICE fields.
3141235 (1112752)
The deletion of a PDS member in a secure region now use the correct classes.
3140443 (1112709)
Sometimes the STOP button for connected clients in ESMAC was not displayed when security was on.
This has now been fixed.
3139885 (1112724)
Date and time filter values are now retained when the jobs are filtered to user requirements in ESMAC.

•

3138516 (1112498)
The Reply button for a waiting from console JOB in ESMAC is now enabled or disabled depending on
user authority.

•

3137426 (1112397)
The environment variables ES_DISABLE_DFLTUSR_SIGNON/
ES_ESM_DISABLE_DFLTUSER_ESMAC are now correctly honored in secure regions.
3133646 (1112061)
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•

When specifying the ES_MAX_CATALOG_LINES environment variable, one line fewer were displayed
in the ESMAC catalog view. This has been fixed.

•

3129034 (1111563)
The 9/041 error no longer occurs when accessing catalog after running a job that accesses the proclib.

•

3122584 (1111066)
An issue in the date and time filters in the ESMAC spool display page has now been fixed.

•

•
•

•

3122475 (1111003)
The Job page now displays in Shift JIS encoding if the operating system encoding is determined to be
Shift JIS.
3115107 (1110311)
The SIT 'New' button is no longer greyed out when the ESMAC user has the appropriate permission.
2913474 (1108809)
If the Data File Editor was used to retrieve the DCB information for a data file hosted by Enterprise
Server and the catalog did not contain a physical filename, an RTS 114 error would be encountered.
This has now been fixed.
A user setting ES_CICS_SINGLE=Y enabled them to signon to more than one terminal at a time. This
has now been fixed.
2913254 (1109223)

•

The PostgreSQL switch module now loads correctly in 64-bit mode.

•

3149380 (1113516)
A problem recovering from errors where SQL Server unilaterally terminates an XA transaction has been
resolved.

•

3145058 (1113133)
User Impersonation now works as expected when using an ODBC switch module in batch mode.

•

3140100 (1112655)
The ESMSSQL switch module no longer returns an RTS153 error if USERP=T is set and the user does
not exist.

•

3140097 (1112649)
The Oracle switch module no longer fails with an RTS153 error when being enabled after an initial
connection error.
3129198 (1111608)

•

Auditing using syslog now reconnects correctly after the syslog server restarts.

•

3135191 (1112186)
Auditing modules are now loadable on all supported platforms.

•

3124417 (1111183)
Syslog messages can now be configured to use TLS as the transport protocol.

File Handling
Back to the list
•

•

Users, Groups, and Classes can once again be searched based on substring matches, rather than full
exact matches.
3127314 (1111414)
Password Expiry and Account Expiry dates are now correctly displayed in the ESF LDAP Security
Administration Web Interface when specifying times in 24 hour format.
2883964 (1107911)
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•

•

The Users in the "Members" list for Groups and Groups in the "Group Membership" list for Users are no
longer incorrectly filtered by the filter on the respective "Users" and "Groups" main tabs.
2871547 (1106121)
The ESF LDAP Security Administration Web Interface no longer incorrectly displays a blank Users/
Groups list when changing tabs.
2863056 (1104795)

•

•

The REPRO of a cluster that contains an alternate index no longer performs the copy using the
alternate index. It uses the primary index instead.
3136566 (1112386)
When running under a mainframe emulation, if the INDD record length does not match the cataloged
length for SYSIN when performing an ACCEPT statement, and that results in a partial record being
read, that record is now returned (as it does on the mainframe).

•

3120786 (1111421)
9/41 additional statuses 2, 4, 5 are no longer printed to the log without an associated log entry for the
actual 9/41 error.

•

3115318 (1110341)
Setting RUNITLOCKDETECT=OFF no longer causes an unhandled exception when a file is opened
multiple times in managed code.

•

2885757 (1108212)
File Handler settings supplied by the extfh.cfg configuration file are now captured in CTF tracing of the
File Handler.
2849599 (1102983)

•

•

•
•

If, in a single process, Fileshare is called with both FCD2 and FCD3, the filename sent to Fileshare no
longer becomes corrupted.
3131960 (1112168)
The reading of keys no longer fails when the indexed file that was open prior to the current file was not
explicitly closed.
3129038 (1111565)
The EXTFH option RETRYOPEN has no effect when set in the Fileshare Server configuration file.
3106992 (1111699)
An SPLJNO filename will no longer become corrupted when being accessed simultaneously through a
Fileshare server currently under load.
3106992 (1112094)

•

iFileshare no longer hangs during a stop run operation if files being used in the program are accessed
through different iFileshares.
3142333 (1112939)

•

MFJ_INPUTDS_ERROR=N is now honored for DFSORT and ICETOOL emulation.

•

3151761 (1113797)
ICETOOLS DISPLAY operators now display correct formats.

•

3132530 (1112032)
SORT CODE EQ NUM is now working as expected with EBCDIC records.

•

3113121 (1110145)
For dataset names that contain an environment variable that holds the name of a Fileshare server,
MFJSORT will no longer give a 9/004 file status.
3109801 (1109898)
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•

MFJSORT will now correctly close all opened files in the case where each file in the output group is
handled differently. Thus, SYNCSORT behavior is now the same between versions 2.3 and 2.3.2

•

3106550 (1109627)
Sorting concatenated LSEQ or NULLFILE/DUMMY files no longer produces an error.

•

3106223 (1109452)
During a SORT operation, SEQNUM now correctly starts at sequence number 1.

•

3106111 (1109444)
MFJSORT now correctly treats LSEQ files as CHARSET ASCII regardless of CHARSET setting.

IBM Language Environment for OS/390 & VM Support
Back to the list
•

•

A problem was encountered with assigning heap storage after it had previously been cleared using the
CEEGTST and CEECRHP Language Environment routines used in 64-bit mode (COBMODE=64). This
has now been fixed.
3104480 (1110751)
Calling the Language Environment modules CEE3GRP and CEEMRCE no longer results in an RTS
173 error. See "Enable Language Environment (LE) Support' in your product help for details on how to
enable LE support.

IMS Support
Back to the list
•

A problem that sometimes caused a read-only IMS batch program (PROCOPT=GO) to encounter an
incorrect status code of AI has been fixed.

•

3145385 (1113189)
An invalid GD or GE status code was issued when inserting a physical child of a logical parent using a
logical view when the virtual logical child was defined with multiple sequence fields. This has been fixed.

•

3143889 (1113032)
An "AO" status code was sometimes erroneously returned when updating a logical parent database
through a logical view. This has been fixed.

•

3140617 (1112764)
An erroneous DJ status was returned to a REPL call when a DLI call was issued to another PCB
between the GH* call and the REPL call. This has been fixed.

•

3140173 (1112684)
An erroneous DA status was returned to a REPL call when the GET-HOLD call preceding it was only
partially successful. This has been fixed.

•

3138482 (1112600)
A GNP call following a GE (not found) status sometimes returned incorrect PCB key feedback
information. This has been fixed.

•

3137412 (1112558)
The mfims imsdbu ADD command incorrectly required the REPLACE/NOREPLACE directive to have a
value. This has been fixed.

•

3125697 (1111332)
The IMS Recovery Utility has been updated to enable you to specify a point in time at which to recover
a database. See your product documentation for details.
3117798 (1110547)
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•

•

When using an IMS DB Catalog file (IMSDBCAT.DAT) in support of Remote IMS or USERDB exit, a
program that issued a restart (XRST) or checkpoint (CHKP) call resulted in unpredictable behavior. This
has been fixed.
3108346 (1109655)
An x'0900' was incorrectly returned in the AIB return code for an EBCDIC application using the AIBTDLI
interface. While this did not affect the success of the call, return code has been corrected.
3106210 (1109548)

•

The ESMAC > SPOOL page now displays the JOB START and JOB END times.
2886742 (1108293)

•

A problem with MFS generation not properly generating MID output for TN3270 devices has been fixed.
All TN3270 devices always default to Input/Ouput and always generate a MID and DIF in addition to
MOD and DOF unless explicitly defined otherwise by the DIV macro in the MFS source.

•

3151923 (1113702)
A problem with MFS generation that incorrectly caused multiple input segments for OPT=2 type MFS to
be shortened has been resolved.

•

3148697 (1113538)
A problem that caused messages sent to the terminal by IMS to display on a blank screen instead of in
the SYSMSG field defined in the MFS source has been fixed.

•

3147331 (1113351)
A problem that caused print output to be formatted incorrectly when consecutive output fields had no
space between them. This has been fixed. This fix requires that you regenerate MFS source.

•

•

3143588 (1113101)
A problem that caused an incorrect cursor position in the I/O area of an IMS program has been fixed.
This fix applies to both ASCII and EBCDIC, and is not affected by MFS data case conversion. MFS
regeneration is not required.
3141057 (1112928)
A problem that caused abends when formatting printer data has been fixed.

•

3138921 (1112865)
A problem that sometimes caused MFS formats designated as output only to incorrectly generate an
input format has been corrected to now generate only the appropriate MOD/DOF output control blocks.

•

3135140 (1112240)
Trailing spaces are no longer be removed from the input message when OPT=2 is specified in the MFS
source.

•

•

•

3131882 (1112075)
The input field (MFLD) that was mapped from a nonexistent device field (DFLD) has a default literal
assigned to it. Previously, this literal was ignored. The literal value (in this particular case, the tran code)
is now moved to the input buffer even if the device field does not exist.
3131869 (1111904)
When multiple MODs referenced a different subset of DPAGES from the same device, MFS generation
output was incorrect, causing IMS to hang at run time. This has been fixed; however, to correct the
problem, you must regenerate the MFS after installing this update.
3123517 (1111315)
When FILL=NONE is specified on the DPAGE macro in the MFS source, the output screen fields will be
padded with whatever character is specified in the MOD. Otherwise, the MOD fill character is ignored.
Regenerate your MFS in order for the appropriate flags to be updated.
3118064 (1110571)
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•

Light pen support has been added to IMS MFS.
2870473 (1105952)

•

•

A PURG call to a modifiable alternate PCB issued without first establishing a destination returned a DLI
status of A3. This has been changed to return a DLI status of spaces provided there is no message to
insert.
3129240 (1111770)
A problem that caused a parsing error on parameters provided for EXEC DLI has been fixed.

•

3128279 (1111493)
A problem that caused the EXEC DLI preprocessor to incorrectly parse inner parentheses and issue an
error message has been fixed.

•

3115734 (1110379)
A problem that caused a "Not Protect" condition to return a 0000 status code in the auth I/O area
feedback has been fixed to correctly return a 0004 code.
3110324 (1109823)

•

•

A problem that caused an IMS TM transaction to wait indefinitely for a response from an external
resource manager has been fixed to terminate the transaction when its process time limit is exceeded.
3145988 (1113188)
When users switched activity between two or more LUs (terminals), a new signon to a previously used
LU failed to return the signon initial screen produced by the <transaction-id>. The failure was specifically
associated with the following configuration combination: ES_CICS_SINGLE=y ES_DFS3650=TRX
ES_IMS_FORCE_SIGNON=Y ES_IMS_GOTO_CICS_ON_SIGNOFF=Y ES_TRX3650=<transactionid> This failure has been resolved.

•

3144089 (1113054)
A problem that caused a loop in CASTMC when an XA resource manager was enabled has been fixed.

•

3141157 (1112874)
Asynchronous/unsolicited output to an IMS Connect client is now supported.

•

•

3140384 (1112781)
MQ-IMS Bridge output messages can now be routed to a reply queue based on LTERM, as configured
using the new OTMA destination-descriptors environment variable, ES_IMS_OTMA_DEST.
3139850 (1112808)
Sporadic memory corruption in CASTMC no longer occurs.

•

3134730 (1112708)
A problem that caused an RTS114 error when a second IMS sign-on from a user already associated
with a different logical terminal has been fixed.

•

3128579 (1112160)
A problem that incorrectly caused an DFS2082 system message to be returned to an IMS Connect
client by an IMS application has been fixed.
3109139 (1110050)

Interface Mapping Toolkit
Back to the list
•

A problem that caused memory leaks in JSON-based Web Services has been fixed.
3109465 (1109773)

J2EE Connector
Back to the list
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•

You no longer receive Java heap errors when a resource adapter is passing large amounts of data.

•

3120684 (1110892)
JSP generation works correctly when there are OCCURS fields.
2869932 (1105858)

Java Support for COBOL
Back to the list
•

The Javademos Readme files have been updated with new instructions.

JCL Support
Back to the list
•
•

•

A file locked error (9/068) on SPLJOB, occurring after deleting a printed dataset, has been corrected.
3151227 (1113747)
If you are using wildcards to identify the datasets on which to perform a function of the public catalog
interface program (mvscatpb), and the dataset name criteria is 44 characters or more, you should use
the * wildcard as the first character of the dataset name.
3149739 (1113570)
A failure to submit JCL jobs from a CICS program via the internal reader has been corrected.

•

3148986 (1113522)
MFJAMS (IDCAMS) does not rename the members of a dynamic PDS when the cataloged PO dataset
is renamed.

•

3146461 (1113337)
Using MFFTP, when you GET a FB file, the file retrieved is now padded with low-values to the length of
(or a multiple of) the LRECL.

•

3141536 (1112787)
If a job fails and leaves active GDG biases, the next job that requires use of the GDG will reset the bias
numbering to include the active biases from the failed job.

•

•

3141379 (1112768)
The use of the environment variable ES_CATLG_DISABLE_ADDITIONAL_QUAL has been replaced by
a check box named Disable Additional Qualifiers, which is located on the ESMAC Data Catalog page.
The functionality provided by the new check box is equivalent to that of the variable: when checked, the
use of additional qualifiers when displaying data sets in the catalog is disabled; for example, when
checked, a filter of A.B would only return a data set of A.B. When unchecked, a filter of A.B would return
all data sets starting A.B (as if A.B** had been entered).
3138176 (1112494)
Test comparisons now works as expected for nested procs with duplicate step-names.

•

3136138 (1112290)
MFJSORT now handles concatenated variable length LSEQ input files correctly, and does not generate
a 9/139 error.

•

3135888 (1112365)
A problem with Job Ready and Job Submitted messages not appearing in SSTM-enabled regions has
been corrected.

•

3135320 (1112207)
GDG generation count is now correct when the GDG is defined with SCRATCH and EMPTY options
and generations during DD processing.
3134244 (1112355)
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•

•

3133201 (1112011)
A change in the tracing of the IDANIP01 module, introduced in ED 3.0 PU3, and was producing an RTS
114 error when tracing SSTM jobs, has been corrected.

•

3133184 (1112035)
The environment variable ES_CATLG_DISABLE_ADDITIONAL_QUAL now no longer affects results
from the MVSCATIO if calls were made from utilities such as IDCAMS.

•

3132978 (1112009)
Multiple quoted parameters are now permitted on the MFFTP input line.

•

3132764 (1111982)
MFFTP now allows the use of input datasets with an LRECL greater than 80.

•

3132360 (1111960)
MFFTP no longer leaves a lock on a dataset when it executes a GET command.

•

3131732 (1111951)
An RTS 114 error reported when deleting the last batch job from the spool has been corrected.

•

3131671 (1111884)
MFFTP now works as expected when large files are transmitted.

•

•

3129865 (1111862)
The processing of IP format in OUTPUT statements has been corrected so that it does not cause JCL
parser errors.
3129388 (1111604)
A problem transferring LSEQ format files in MFFTP has been corrected.

•

3129323 (1111606)
When environment variable ES_PROG_PATH is set to 'Y', a program's load path can be viewed in the
JESYSMSG and also in SYSLOG.

•

3123641 (1111130)
The job record now holds the correct numbers of HELD, OUT, and COMPLETED spool datasets after
the spool conversion utility (SPLCONV) has been run.

•
•

3123298 (1111314)
A problem with initialization of a procedure in the first job that a SEP runs has been corrected.
3123002 (1111050)
Calling MFJZLOG from a CICS or IMS region is supported if the region is SSTM-enabled. The API is
not supported to run under ES for .NET.

•

3122665 (1111137)
When a dataset rename operation fails, the physical file is no longer renamed.

•

3117963 (1110582)
MFJPTPCH now works correctly when the input dynamic PDS path contains an environment variable.

•

•
•
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results of an IDCAMS LISTCAT LVL step.
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3113225 (1110193)
The GDG-CURR-BIAS value in the CATALOG is now correctly updated when the current GDG bias is
deleted.
3112986 (1110127)
The JOBRC parameter on a JCL JOB statement is now parsed and ignored.
3107427 (1109575)
The COND CODE from an MFFTP step that errors calling sftp is now set to at least 4. Should MFFTP
detect ‘ERROR’ status messages in the output from the mfsftp script, it will set the return code to 8.

•

3106682 (1109971)
Referback on DCB now resolves correctly when only the PROCSTEPNAME is mentioned without the
STEPNAME.

•

3105486 (1109350)
A problem with the catalog listing returning extraneous PO entries when a wildcard had been specified
has been corrected.

•

2883777 (1110201)
There is now a marked improvement in the time taken to filter the catalog list when asking for just one
record and ES_CATLG_DISABLE_ADDITIONAL_QUAL=Y is set.

•

2883777 (1110148)
MVSCATPB no longer incorrectly applies values from previous records when updating a catalog record.

•

2881470 (1107585)
The error reporting in MFJAMS has been improved so that it reports the file status of the file, along with
return code of 16, when a DELETE fails.

•

2875995 (1106881)
A number of enhancements have been made to the behavior of user catalogs to make them more
resilient. See 'Support for Multiple Catalogs' in the documentation for full details.

•

2868958 (1105727)
ES_ALLOC_OVERRIDE now honours PO and PDSM rules specified in the configuration file.

•

2866945 (1105413)
When using the MFFTP utility, trailing blank spaces in generated 'lcd' commands are now removed.
The ES_ESMAC_DISP_MAX_OVERRIDE environment variable now has an effect when files are
accessed directly from the job list page.
A problem where MFUSERCAT_BASE_LOC was not prepended to any catalog file that did not specify
a path has been corrected.
A 'Binary Flow Mismatch' error when using casout to kill a non-existent job has been corrected.
A failure to grant access to a dataset with a PHYSFILE rule that did not end in with a wildcard has been
corrected.
The incorrect application of JOB KEEP entries in the spool housekeeping utility has been corrected.
4-digit condition codes that include a cond-code type are now returned correctly in the public spool
interface (mvscaspb).
Flushing a job no longer results in spool records for a different job being deleted.

•

ESMAC now displays the correct number of lines that the user has selected in the spool view.

•

3100998 (1108889)
If "Local ES Security Enabled" is enabled in ESMAC, Enterprise Server now verifies whether the user
has sufficient permissions to submit jobs.

•
•
•
•
•
•
•

2837220 (1101415)
MF Common Client
Back to the list
•

•

The Micro Focus Common Client now allows the comma character in HTTP URLs. This affects COBOL
web services clients, CICS Web Interface, and CICS Web Services.
3127463 (1111430)
MFCC will now always allow the use of a CCI.INI file without crashing.
3123531 (1111144)
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MF Communications Server
Back to the list
•

•

•

•

Enterprise Server and the Micro Focus Common Client now support opening more than 256 SSLenabled endpoints simultaneously. Also, a resource leak in the MFCS process for HTTPS connections
made with CICS Web Interface or CICS Web Services has been fixed.
3137166 (1112477)
A situation where some terminal emulators were unable to connect to an enterprise server region has
been fixed.
3135166 (1112195)
The maximum size of an HTTP header value allowed for a CICS Web Interface or CICS Web Services
server can now be configured. Include an [HTTP] section in the configuration information on the Edit
Communications Process page, and use the option 'maximum header value length=<num-of-bytes>'. If
not specified, the default number of bytes is 1024.
3127781 (1111480)
A bug that caused some clients to crash MFCS when submitting 3-character trancodes has been fixed.

•

3121264 (1111026)
Enterprise Server now correctly handles chunked HTTP message bodies. The CRLF sequences, which
appear after each chunk, are now removed when the chunked body is consolidated.

•

3100279 (1109784)
The Enterprise Server Communications Process (MFCS) can now restrict access to listeners by client
address. See "Conversation Filtering" in the product Help for more information.

•

2887418 (1108517)
Enterprise Server's backward compatibility with older versions of MFDS has been restored.

MF Directory Server
Back to the list
•

•
•

•
•

•
•
•
•
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| Resolved Issues

Automatic corrections are now made to invalid Enterprise Server listener ISC configurations when they
are loaded or imported.
3136730 (1112328)
Regions exported using MFDS now include the IMS query name if present.
3130077 (1111684)
A missing product HTML file could cause the Enterprise Server Administration HTML GUI to revert to
using English text rather than the configured language. This is now fixed.
3118363 (1110595)
A memory leak in the MFDS process which could cause an intermittent crash has been fixed.
2886846 (1108593)
The "mfCASIMSMFSNullChar" and "mfCASIMSTMMQColdStart" IMS region attribute values are now
imported correctly from a previously generated XML export from the Micro Focus Directory Server.
2879665 (1107226)
The "IMS Configuration Directory" configuration value has been deprecated and has been removed
from the Enterprise Server Administration Web UI for Enterprise Server instance properties.
For additional security, any start, stop or not-responding region scripts region will only be executed if the
Micro Focus Directory Server restricted administration is enabled.
You could get an RTS115 error in MFDS on AIX when performing certain actions such as browsing the
properties of an ESM.
When executing Enterprise Server in a Docker container, you need to set the
MFDS_EXTERNAL_ADDR environment variable to a resolvable external address string (a hostname

•
•

rather than an IP address) in the Docker environment. This is to enable client browsers to resolve
ESMAC and other URLs in Enterprise Server Administration. The value of this variable will replace the
internal container address in the URL.
The Enterprise Server Administration Web UI "Directories" menu item and functionality has been
deprecated and is no longer available.
If MFCS control channel is configured to use SSL, MFDS must have an environment variable "MFDS_
$SERVERNAME_CAROOT" defined, which points to the full file path of the CA root certificate used to
sign the control channel's certificates.

Mainframe Access
Back to the list
•

MFDAS now correctly imports binary data as binary when MFDAS_CODE_PAGE was set to a DBCS
page. Previously, it was imported as ASCII.

•

3150576 (1113612)
MFDAS import commands using file as *.* or type as AUTO now download correctly.

•

3145965 (1113223)
MFA DBCS calls now use an appropriate SBCS default.

•

3144286 (1113100)
Eclipse no longer crashes when calling commands after an MFA rename.

•

3143624 (1113181)
Using the MFDAS DIR END FILTER command no longer causes a crash.

•

3136640 (1112468)
When using a codepage other than IBM-037 syncmon2 could fail to sync PDS members that contained
the section symbol in their name. This has now been fixed.

•

3130696 (1111807)
MFDAS KSDS-FIXED import no longer ignores fixed files.

•

3129963 (1111679)
An issue with the MFDAS /FIXEDVSAM parameter has been resolved.

•

3129963 (1111680)
The MFA_SERVER_PARMS environment variable now changes the Mfdeamon query when user
credentials are not known.

•
•
•

3127797 (1111962)
MFDAS STATUS jobname filter now works as expected.
Specifying invalid SSL details when configuring AWM in Eclipse no longer causes exceptions.
Adding new Eclipse RSE connections no longer results in Eclipse emptying the MFA registry entries
when you close the IDE.

•

•

MFA now supports a new configuration parameter JES_CONCHAR for installations that do not use the
default '$' character for JES console commands.
3142873 (1113084)
When performing a delete from the JES spool first check if the user is the owner. If true then allow the
delete to proceed, else check the normal RACF JESSPOOL and JESJOB classes to determine if the
user is authorized to perform the action. If no JESSPOOL or JESJOB classes are present then deny.

•

3141208 (1113585)
An occasional 0C4 in DCPSAF caused by a memory overwrite has been fixed.

•

3129416 (1111732)
MFDAS import requests made to Endevor now honour the PGRP (processor-group) parameter.
3127644 (1111509)
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•

•

•

The Endevor transient data set allocated to ENDVLIST has had its maximum space allocation increased
to enable handling of large history listings.
3122295 (1110989)
A program using the ACCEPT FROM SYSIN statement to read a data set on the mainframe failed to
release the data set when the step had completed. The data set remained locked to the Data Connect
mainframe process. This has been fixed.
3122245 (1110995)
Previously, when updating an Endevor element with a workstation file containing zero-length records
they were always treated as updates. Writing at least one blank now avoids this and no update takes
place.

•

3105518 (1109752)
The file handler was sending a function code that was not recognised by MFA causing an abend 0C4.
This has now been fixed.

•

3105465 (1109897)
Default parameters in the PARMS member where incorrectly set. These have now been restored to the
defaults as documented.

•

The command line utility MFMON2 will now exit and return an error message if it is unable to create the
temporary files it requires to run.

•

3123995 (1111268)
The MFA Synchronisation and Control Monitor did not correctly synchronise mainframe datasets whose
members contained a $ character.

•

3121666 (1110909)
The compare and synchronization monitor command line utility MFMON2 was failing if more than 4000
files were synchronised. This has been fixed.
3104574 (1109235)

•
•

An abend 02A will no longer occur if submit and PDS hash functions execute at the same time.
3135556 (1112256)
User code now runs in an independent address space in the Mainframe Call Generator. It previously ran
in the Mainframe Access address space meaning it was technically possible for the code to enter
supervisor state. MCGLIB now becomes the new address space's STEPLIB so other user modules can
be called from the first one without placing them in MFA's STEPLIB.
2120159 (1057612)

Micro Focus Batch Scheduler Integration
Back to the list
•

•

%%INCLIB Control-M statements, used in a conditional block (%%IF, %%ELSE, and %%ENDIF), are
now executed or skipped as expected.
3128402 (1111552)
By default, performing a soft-kill on an MFBSIJCL process that is waiting for JOB termination also
cancels the JOB in Enterprise Server before terminating. Use the following parameter in the MFBSI
configuration file to avoid killing the JOB when the process is soft-killed: ES_JOB_KILL=NO (By default,
ES_JOB_KILL=YES is assumed.)
3120998 (1110950)

Micro Focus Cryptographic Library
Back to the list
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| Resolved Issues

•

The MFDS could crash during startup when SSL and a keyfile with no password are used to secure it.
3152964 (1113791)

Monitoring and Management
Back to the list
•

JCL jobs that generate STEPBYPASSED events no longer cause incorrect values in JCL HSF records.
2886646 (1108200)

OLE Class Library
Back to the list
•

An issue with the tabbing of ActiveX controls has been resolved.
3106202 (1109437)

OO Base Class Library
Back to the list
•

The SortedCollection class methods setSortMethod and setSortEntry are now thread-safe.

•

3145921 (1113207)
The class libraries resources now compile without having to add the Windows SDK include location to
the INCLUDE environment variable.

•

3117380 (1110512)
Menu item objects are not destroyed until the on idle processing. This is to stop the destroying from
being attempted twice.
3107820 (1110204)

Run-Time System
Back to the list
•

IBM floating-point behavior is now supported in managed code via the MAINFRAME-FLOATING-POINT
Compiler directive.
3111511 (1109931)

•

•

•

•

•

When native COBOL calls a Java method that returns an array of objects, the returned object reference
now correctly represents the array of objects.
3144462 (1113127)
When creating a live recording file, if you specify a path in the COB_LIVE_RECORD environment
variable, the path is now validated (to ensure it exists) before the process runs.
3136927 (629611)
A new tunable has been introduced, dbcs_text_enable_clip, which when set to true ensures that the font
is clipped to the font height supplied by Microsoft Text APIs rather than overwriting pixels beyond the
font height. Use this tunable when running in a GUI window (runw). The default is false.
3136924 (1112338)
The NUMPROC"ACOS" directive has been enhanced to support certain elements of NEC ACOS
COBOL relating to the processing of invalid data in USAGE DISPLAY data items.
3135821 (1112242)
A bug in the NUMPROC"ACOS" emulation of NEC ACOS COBOL has been fixed. The error occurred in
statements of the form: move unsigned-display-item to numeric-edited-item where the source item
contains a negative value.
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•

3135821 (1113569)
The NUMPROC"ACOS" directive has been enhanced to support certain elements of NEC ACOS
COBOL relating to invalid sign information in USAGE COMP-3 data items.

•

3135820 (1112241)
In the run-time text window, the correct key-code is now returned when the Tab key is pressed after the
Window menu has been previously selected using the Alt + Space shortcut.

•

•

•

3131065 (1111843)
A GUI application no longer fails to terminate correctly if the title bar of the text window console is
currently selected with the mouse when the termination occurs.
3124823 (1111218)
OO CTF tracing now correctly outputs the thread-id to file.

•

3117361 (1110510)
When using .INT code, an arithmetic statement involving a 64-bit COMP-5 operand now gives the
correct results.

•

3111631 (1109997)
When entering multiple DBCS characters using the IME, the later characters in the string are no longer
being corrupted. Previously, corruption occurred due to a bug in Microsoft's ReadConsoleInput() API.

•

•

•

•

•

•
•
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3132989 (1111983)
The position and size of windows created with the WINDOW-CREATE clause in Dialect(RM) will no
longer be constrained by the window that was active when the call is made. Previously, a window
created by WINDOW-CREATE would be required to fit within the constraints of the parent window. This
behavior was not consistent with the same command under RM/COBOL, and so was changed.

| Resolved Issues

3111356 (1109909)
A new parameter is available for the CHECKDIV Compiler directive that emulates behavior when
attempting to divide by zero on an ACOS mainframe system. CHECKDIV"ACOS" will result in both the
quotient and the remainder being set to the value of the dividend if a divide by zero operation is
attempted when no ON SIZE ERROR clause is specified.
3111073 (1109890)
The NUMPROC Compiler directive has a new parameter. NUMPROC"ACOS" provides partial
compatibility with the behavior of NEC ACOS COBOL processing of invalid data in USAGE DISPLAY
data items.
3111072 (1109889)
On file systems that support 64-bit inode numbers, CTF output files were not produced in the expected
directory if its inode number was sufficiently large that it did not fit in 32 bits. This has now been
corrected.
3109110 (629772)
When using the COBOL printer routines, the default printer is now selected on Windows Server 2016.
Registry differences introduced with Windows 10/Sever 16 caused existing functions to select the wrong
default printer. These have now been updated to use an alternative method to achieve the correct
result.
3109043 (1110153)
An intermittent runtime error (COBRT255: CODESET cannot open double byte conversion table) could
occur when MFCODESET was set to a value that included double byte conversions. This has been
fixed.
3108885 (1109915)
The correct status-code definitions (for Windows and UNIX) are now recorded in the documentation.
2879887 (1107243)
Improvements have been made to the run-time system, the File Handler and the JCL engine, with
regards to error trapping and reporting.

•
•

2867927 (1106202)
Spurious errors no longer occur when compiling or running programs on 32bit Linux platforms with an
XFS file system greater than 1TB.
COBUTF8 no longer segfaults if COBDIR is not set.

Setup Issues
Back to the list
•

The DemoCA installer now works correctly on Japanese OS.

•

3142481 (1112900)
An issue with some empty folders created during installation ad not deleted when the product was
uninstalled has been resolved.
3115392 (1110376)

HCO for DB2 LUW
Back to the list
•

•

•

•

The DB2 preprocessor sometimes generated a 309 malformed subscript error if the SQL statement
contained COMP host variables with an indicator variable array. This has been fixed.
3142686 (1112952)
A problem that prevented the use of CBLLINK on compiled programs that use LITLINK has been fixed.
HCO now supplies the LIBs necessary to link these applications. Note: If you compile static DB2
applications that use LITLINK, you must compile them using the DB2(NOPRE) directive, and specify all
applicable LIBs in the LINK statement. For example: CBLLINK SELECT.obj DB2API.LIB,
MFHCOLIB.LIB, MFSQLSMF.LIB
3135847 (1112270)
The DB2 preprocessor incorrectly generated code to convert COMP fields in SQLCA if no SQL
statement was found in the program. This resulted in error "COBCH0002 Undefined ECM error. Inform
Technical Support. Error code 309". This issue has been resolved.
3129362 (1111619)
The DB2 preprocessor has been enhanced with a new directive option, DB2(STOPROC), that provides
a solution to a problem that prevented DB2 LUW stored procedures from working properly when
compiled with CHARSET(EBDIC) because character information is passed to and from DB2 LUW as
ASCII data.

•

3129260 (1111614)
A problem that caused the DB2 preprocessor to generate DB103 errors on mainframe-style VARCHAR
host variable definitions has been fixed.

•

3123813 (1111337)
When run against DB2 LUW version 10 or later, the HCO DCLGEN tool sometimes defined the first
column in a DECLARE TABLE statement incorrectly by dropping WITH DEFAULT. This has been fixed.

•

3119616 (1110699)
The DB2 preprocessor and HCO runtime have been updated to convert an entire VARCHAR field to
EBCDIC rather than just converting the length of data specified. This corrects a problem with erroneous
ASCII spaces showing up in VARCHAR columns.
3110220 (1109819)

SQL: HCO for SQL Server
Back to the list
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•

•

When using HCOSS Generate DDL to generate tables and columns from mainframe code that
contained REMARKS containing single-quote characters, a SQL Server DDL syntax error occurred. To
correct this, REMARKS are now generated using two single-quote characters in place of each singlequote character found in the mainframe code.
3137298 (1112507)
A problem that occurred when using the HCOSS Generate DDL tool generate unique filtered indexes
with nullable columns caused the columns to be generated incorrectly. This has been fixed such that the
columns are now generated using a WHERE <column_name> IS NOT NULL clause. In addition,
nullable columns defined in unique indexes were not being evaluated with regard to adding the WHERE
NOT NULL clause. This has been fixed as well.
3107289 (1109778)

•

•

•

The HCOSS DB2 grammar was erroneously generating a syntax error when the mainframe character
STRIP function was used with the BOTH option. This has been fixed.
3140519 (1112698)
HCOSS data transfer was failing if more than one version of SQL Server was installed on the machine.
This is now fixed.
3132833 (1111996)
When using SQL(DIALECT=MAINFRAME) the STRICTPARSE directive is now set by default, and can
be disabled by specifying NOSTRICTPARSE. This is a change from earlier releases in which the default
setting was NOSTRICTPARSE.

SQL: MBDT Utilities
Back to the list
•

•

DSNUTLB LOAD no longer gives an SQL error for columns that are defined as DECIMAL EXTERNAL
and that have a POSITION clause containing only a start position, but no end position.
3139744 (1112632)
A problem when that occurred when querying referential integrity information for a table has been fixed.
In addition, a problem with CompiliOptionBlock being out of sync with new ESQL directives has been
fixed.
3119350 (1111458)

SQL: OpenESQL
Back to the list
•

•

•

•

OpenESQL now supports RETURNING clauses in INSERT, UPDATE and DELETE statements when
using SQL(DBMAN=ADO) and SQL(PROCOB).
3120916 (1110849)
A problem when using an Oracle REF CURSOR in managed code that sometimes caused subsequent
statements to fail has been fixed.
3113118 (1110287)
Problems with DATE and TIMSTAMP handling when using the Oracle fully managed provider for
ADO.NET have been fixed by introducing new environment variables to control .NET formatting of
datetime and datetimeoffset values when DATE=EXTERNAL is set for Oracle connections.
3108444 (1109632)
Problems with DATE and TIMESTAMP handling when using the Oracle fully managed provider for
ADO.NET have been fixed by introducing new environment variables to control .NET formatting of
datetime and datetimeoffset values when DATE=EXTERNAL is set for Oracle connections.
3107838 (1109570)
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•

An issue with singleton selects that have no FROM clause but have a WHERE clause has been fixed.

•

3151028 (1113711)
A problem that generated an undefined preprocessor error and caused compilation to fail when a literal
of a size greater than 79 characters was used with the SQL LIKE operator has been fixed.

•

3150466 (1113596)
Previously, when using SELECT... INTO statements containing a FOR UPDATE clause with PostgreSQL
and MySQL, the pseudo column used for positioned updates was not present in tables. A new
OpenESQL directive, SQL(NOWHERECURRENT), is now available. This benefits PostgreSQL and
MySQL applications that do not require positioned update or delete support, and where the pseudo
column used as a rowid to implement positioned updates and deletes is not present.

•

3146620 (1113335)
A problem using "plan" as an SQL identifier has been fixed.

•

3146620 (1113251)
An issue with using the SQL(XAID) Compiler directive with IMS applications has been resolved.

•

3144626 (1113137)
A problem with applications using a very large number of embedded SQL statements has been fixed.

•

3142107 (1113006)
A problem with fetching data into .NET Decimal host variables, causing an invalid overflow error, has
been fixed.

•

3134510 (1112152)
A problem handling .NET string host variables in OpenESQL applications compiled with the 64-bit
COBOL compiler has been fixed

•

3134369 (1112116)
The file cobmfdsntiar.so is now included in the COBOL Server product.

•

3132441 (1112164)
The limit for the number of compiled SQL statements has been increased from 5000 to 12000.

•

•
•

3129084 (1111593)
An inconsistency with the OpenESQL ADO.NET runtime handling of PIC X host variables in DBCS
locales has been fixed.
3128324 (1111562)
A problem with EXEC SQL ALLOCATE for SQL-CLOB host variables has been fixed.
3128295 (1111492)
OpenESQL for ADO has been updated to behave consistently with Pro*COBOL by returning a +1403
SQLCODE instead of an erroneous -1403 SQLCODE when a PL/SQL stored procedure fails to handle
a data-not-found condition.

•

3128289 (1111491)
A problem that prevented the setting of the UNSAFE_NULL directive from the IDE when using
Pro*COBOL has been fixed.

•

3127696 (1111447)
A problem with Oracle scroll cursors that resulted in a backward compatibility issue with Net Express
has been fixed.

•

3126245 (1111648)
If you use an AT db_name clause in a DECLARE CURSOR statement, you no longer need this clause
in statements that reference the cursor, such as FETCH, CLOSE, GET NEXT RESULT SET or
positioned UPDATE and positioned DELETE statements. To maintain backward compatibility the clause
may optionally be included, but it is no longer required.
3124001 (1111150)
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•

•

3123827 (1111128)
A problem with SQL(CHECK) that was introduced in version 3.0 of this product and occurred for DB2,
Oracle, and PostgreSQL with ADO.NET has been fixed.

•

3121267 (1110919)
A problem using AT <connectionName> with COMMIT, ROLLBACK, and SAVEPOINT statements has
been fixed.

•

3115063 (1110308)
A new SQL compiler directive option, PICXBINDING, has been added to OpenESQL to provide more
intuitive behavior for LIKE expressions with SQL Server by enabling greater control of parameter
binding for PIC X host variables.

•

3113999 (1110373)
OpenESQL has been updated to retain the FOR READ ONLY clause when the TARGETDB SQL
compiler directive option is set to DB2.

•

3112785 (1111030)
A problem with fractional seconds truncation when using the legacy SQL Server ODBC driver has been
fixed.

•
•

•

3112499 (1110032)
A problem using SYSTEM_USER in select statements has been fixed.
3111513 (1109934)
A problem caused by OpenESQL rounding a result to a COMP-3 host variable instead of truncating it
has been fixed in the ODBC runtime.
3110902 (1109871)
A problem with OpenESQL trimming trailing spaces in input host variables has been fixed by the
addition of the SQL(PIXCBINDING=FIXED) compiler directive option, which ensures that these trailing
spaces remain intact.

•

3110720 (1110099)
A problem handling unmapped codepoints in DBCS locales when storing binary data in character fileds
and using SQL(ALLOWNULLCHAR) has been fixed.

•

3109266 (1109723)
OpenESQL had a storage limit of 30 characters for a program ID. The maximum has been increased to
128 characters.

•

2884875 (1107982)
A problem that caused OpenESQL to remove any OPTIMIZE FOR n ROWS clause from queries when
TARGETDB was set to DB2 has been fixed.

•

2883301 (1108387)
A problem with HCOSS access plans getting out of sync with the running code and database stored
procedures and metadata when a live ES region is updated has been fixed.

•
•

•
•
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A problem that caused the OpenESQL preprocessor to generate invalid code when "AT xxxx SELECT"
was specified in an array singleton SELECT statement in managed code has been fixed.

| Resolved Issues

2877693 (1110926)
OpenESQL has been updated to support the OPTIMIZECURSORS SQL compiler directive option for
the OCI and JDBC run-time systems.
The SQL(TRANSACTION) directive now accepts an additional option, AUTO.
SQL(TRANSACTION=AUTO) is equivalent to SQL(AUTOCOMMIT). For new applications,
SQL(TRANSACTION) is the preferred method for specifying transaction options.
PostgreSQL versions 3.2.2 and later are now supported with .NET COBOL.
Operating System authentication for CONNECT statements is now supported for Oracle, DB2, and SQL
Server in the ODBC, ADO, and JDBC run-time systems.

SQL Option for DB2
Back to the list
•

A problem that caused an AUTOBIND support routine invoked by the XDB ECM to fail by omitting the
drive letter in log file names when the specified drive letter was other than C: has been fixed.
3114069 (1110423)

•

The XDB ECM now supports the z/OS DB2 NEXTVAL reserved word as an ordinary identifier.

•

3120469 (1110834)
A problem that prevented the SQL Option for DB2 ECM from recognizing IN clause predicates
containing multiple group host variables has been fixed.

•

3115066 (1110310)
A problem that prevented the SQL Option for DB2 ECM from supporting the use of a collection ID for
validating SQL against z/OS DB2 with DYNAMICRULES BIND packages has been fixed.
3112996 (1110332)

•

A problem reading XDB translation files caused by stack initialization on Windows 10 has been
resolved.
3120927 (1110988)

•

•
•

A problem that resulted in an X352 thread access violation due to an improper reallocation of the parse
tree when using an inner join to a table expression containing a scalar subquery has been fixed.
3132740 (1111977)
A problem with CASE expressions resolving host variables has been resolved.
3131966 (1111932)
A problem with the lexical analysis of a PARTITION BY SIZE clause on a CREATE TABLE statement
when the integer constant and the "G" indicating gigabytes were not separated by a space character
has been fixed.

•

3129670 (1111676)
An issue with a correlated subquery not returning results due to a problem with the correlation variable
has been resolved.

•

3114811 (1110283)
A problem with the query optimizer incorrectly identifying the step for predicate evaluation of a join
predicate containing a column and an expression has been resolved.

•

3114809 (1110284)
A problem that caused an X352 thread access violation on a VIEW definition containing a select item of
the form name.* has been fixed.

•

3114210 (1110228)
An access violation caused by a long UNC path for the Roaming APPDATA directory on a Windows
machine has been resolved.

•

3112201 (1110021)
A problem that caused the XDB engine optimizer to return an empty result set for range predicates on
join conditions has been fixed.

•

3111742 (1109957)
A problem with the first FETCH operation against a rowset cursor containing a UNION ALL with host
variables has been resolved.

•

3110071 (1109893)
An issue with a LEFT OUTER JOIN operation not retrieving all result set rows has been resolved.
3104216 (1109202)
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•

•

A problem with XDB engines not allowing a GROUP BY to contain an item not in the projection list has
been fixed.
3103832 (1109175)
A problem that caused a PDMP272 – xdb Inner Join Problem message has been fixed.
2887796 (1108361)

•

The Stored Procedure Test tool now sizes the Results tab in the same way as it sizes the other tabs.

•

3148319 (1113402)
A problem with DSNUTILB that occurred when loading a table containing a VARCHAR field has been
resolved.
3128931 (1111587)

XML Support
Back to the list
•

cbl2xml will now work successfully under AIX 7 32-bit.
3109051 (1109699)

•

The XML run-time now handles UTF-16 XML documents correctly.

•

3147256 (1113357)
The XML run-time system now correctly sends the XML instance document as an HTTP POST request
to the URL specified on UNIX platforms.

•

3145761 (1113163)
An RTS 164 error (Run-Time subprogram not found) no longer occurs on some very old versions of
Windows when parsing XML.

•

3142315 (1113028)
The XML run time now correctly sends the XML instance document as HTTP POST request to the URL
specified.

•

3135893 (1112298)
XMLPARSE now returns the full UTF-8 string when XMLPARSE(COMPAT) is specified.
3126921 (1112286)

50

| Resolved Issues

Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).
•
•
•
•
•
•
•
•

2879380 (1107250)
2881923 (1109518)
2913358 (1110961)
3145394 (1113143)
3142564 (1112892)
3129260 (1111765)
3117914 (1111288)
3143624 (1113310)

Other Issues Resolved in This Release
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Unsupported Functionality
This section includes information about features or functionality that are no longer supported.
•
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The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.

| Unsupported Functionality

Installation
Before Installing
Downloading the Product
1. Use the download links in your Electronic Product Delivery email.
For more information follow the links for the installation instructions and the End User License
Agreement.

System Requirements
Hardware Requirements
The disk space requirements are approximately:
Enterprise Test Server
1 GB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
Note:
•
•

This product can be installed on earlier versions of Windows but it has not been tested on them.

Support for development on Windows 8 and Windows Server 2012 has been discontinued. These
platforms are still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are supported.

Software Requirements
Note:
•

•

The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components. It will also install the Micro Focus
Database Engine.
This product includes OpenSSL version 1.0.2n.

Before installing this product, you must have the following software installed on your computer:
•

The Microsoft .NET Framework - the setup file installs the .NET Framework 4.5.2 . You might need to
install the following version of the .NET framework manually, if it is targeted by your applications:
•

Microsoft .NET Framework 2 - if your applications use the ILCLR(2) Compiler Directive or if they
target the .NET Framework versions 2, 3 or 3.5. You might need to download these installers
depending on the .NET Framework you are targeting.
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To download the Microsoft .NET Framework 2 click here.
Microsoft .NET Framework 2 or later is also required for the Micro Focus License Manager if you
install this on a separate machine as a license server.
Note:

•
•

•

•

• .NET Framework 3 is provided with Windows Vista and Windows Server 2008.
• .NET Framework 3.5 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.0 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.5 is provided with Windows 8 and Windows Server 2012.
• .NET Framework 4.5.1 is provided with Windows 8.1 and Windows Server 2012 R2.
• .NET Framework 4.6.2 is provided with Windows 10 and Windows Server 2016.
Microsoft's Web Platform Installer 2.0 if your application targets ASP.NET 4. This installs and sets up
ASP.NET. To download the installer click here.
A Web browser is required for Enterprise Server Administration in Enterprise Test Server.
To use your Web browser offline, you need the dial-up networking feature of Windows installed.
Otherwise you might have TCP/IP errors such as being unable find "localhost" or the numeric equivalent
(127.0.0.1).
To use Enterprise Server Administration, scripting or JavaScript support must be enabled in your
browser. This is on by default in Internet Explorer in most Windows operating systems. Also, active
content must be allowed and not blocked. To enable both these in Internet Explorer:
1. Click Tools > Internet Options.
2. On the Security tab, click Custom Level. In the Scripting section, under Active Scripting, click
Enable.
3. On the Advanced tab, scroll down the list to the Security section, and ensure the item Allow active
content to run in files on My Computer is checked.
Enterprise Server Help requires the Java Runtime Environment on some Windows systems to enable
the Search facility to work.
Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Enterprise Developer client and a new licensing server on
the same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool.
If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.
You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements
To ensure full functionality for some Enterprise Test Server features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Test Server setup file.
Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.

Installation Restrictions and Requirements
Before starting the installation, you should consider the following:
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•

You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

•

Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) from an existing product is stopped and uninstalled. On
Windows, do this as follows:
1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:
net stop mf_ccitcp2
Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.
For MFDS, from a command line prompt enter: mfds -u
For CCITCP2: ccitcp2 -u
To run an earlier version of MFDS as a service after you have installed a later version:
1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:
a. Open an Enterprise Test Server command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2
Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.
MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

•

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time
To use Data Manager, you must obtain an Enterprise Test Server Premium license. Once you have
procured a Premium license, Micro Focus provides an electronic product download (EPD) that enables
you to install the Data Manager for z/OS component, which is a separate installation from Enterprise
Test Server. See Installing Data Manager in your product help for details.

Product Co-Existence
•
•

Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same
machine.
Enterprise Server and Enterprise Test Server cannot coexist on the same machine.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.
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For considerations when installing this product as an upgrade, for additional installation options or nondefault installations and for installing the mainframe components, see Advanced Installation Tasks in your
product Help.

Installing
Note: If there is an earlier version of Enterprise Test Server installed on your machine, check
Installing as an Upgrade first.
These are the steps to install this product:
1. Run the ets_40.exe file and follow the wizard instructions to install the prerequisite software and the
product.
The setup file will also install any missing prerequisite software as listed in Software Requirements.
Note:
•

•
•
•

If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.
Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.
We recommend that you install any updates for the .NET Framework that are available at the
Microsoft Download site.
If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Test Server but you can install it if you wish.

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install any additional components.
The advanced installation tasks include:
•
•

Installing as an Upgrade
Command line installation options

To see this information on the Product Documentation pages on Micro Focus SupportLine, click here.

Installing as an Upgrade
Before installing, check Installation Restrictions and Requirements.
Installing this release as an upgrade will automatically uninstall any HotFixes of the older version of the
product you have installed on your machine.
•

56

| Installation

Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Enterprise Test Server Installation Options
To install Enterprise Test Server you run ets_40.exe which contains a number of product .msi files
(Windows Installer packages). When run, ets_40.exe performs some initial system checks then
sequentially installs the .msi files.
ets_40.exe can take a number of parameters, enabling you to specify a number of different types of
installation:
•

Standard Installation

•

Format:
ets_40.exe
Summary:
Full installation including License Manager and Enterprise Test Server. During installation you can
specify options including the location to which the components are installed.
Non-interactive Installation

•

Format:
ets_40.exe /passive
Summary:
Full installation, but the components are installed non-interactively using default options and
directories.
Silent Installation

•

Format:
start /wait ets_40.exe /q
Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.
Modified Silent Installation
Format:
start /wait ets_40.exe /q InstallFolder=d:\cobolrts
Summary:
Full installation, but the components are installed non-interactively with no user interface, and
Enterprise Test Server is installed to d:\cobolrts.

To see what parameters you can use, execute the following from the command line: ets_40.exe /?.
Note:
•

Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

After Installing
•
•

See Changes in Behavior or Usage in your product documentation and in the Release Notes for
important information about changes in this release that might affect existing applications.
Check the Product Documentation section of the Micro Focus SupportLine Web site for any updates to
the documentation which might have been uploaded.
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Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.
To repair your installation on versions of Windows Vista or later:
1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:
1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.
When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.
Important: The installer creates separate installations for Micro Focus Enterprise Test Server and
Micro Focus License Administration. Uninstalling only Enterprise Test Server does not automatically
uninstall the Micro Focus License Administration or any of the prerequisite software.
To completely remove the product you must uninstall the Micro Focus License Administration as well.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:
start /wait install-file.exe /quiet /uninstall
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Licensing Information
Note:
•
•

•

If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.
Be aware that the person who purchased this product has had to sign a license which states that
you may use this product for testing only, and not for development work. If you are uncertain as to
whether you will need to do development work, we recommend you speak to the person who
purchased the product to see if you need a different license.
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus SupportLine.

To start Micro Focus License Administration
Windows 7 and Earlier

•

From your Windows desktop, click Start > All Programs > Micro
Focus License Manager > License Administration

Windows 8, 8.1, and
Windows Server 2012

•

From the Windows Start screen, click the License Administration tile

Windows 10 and Later

•

From your Windows desktop, click Start > Micro Focus License
Manager > License Administration

Installing licenses
You need either a license file (with a .mflic extension) or an authorisation code which consists of a string
of 16 alphanumeric characters.

If you have a license file
1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:
•

Click Browse next to the License file field and select the license file (which has an extension
of .mflic).
• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.
4. Click Install Licenses.

If you have an authorization code
Licensing Information
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Authorizing your product when you have an Internet connection
Note:
•

It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1.
2.
3.
4.

Start Micro Focus License Administration.
Click the Install tab.
Type the authorization code in the Enter authorization code field.
Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

1.
2.
3.
4.

Start Micro Focus License Administration.
Click Manual Authorization on the Install page.
Make a note of the contents of the Machine ID field. You will need this later.
Do one of the following:
•
•

If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.
If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.
10.Click Install Licenses.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:
•
•
•

The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.
The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.
The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support & Services > Support Resources > All Support Resources. In the Browse by Product
field, click the product you require support for. Click Log into SupportLine.
Note: Some information may be available only to customers who have maintenance agreements.
If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.
Also, visit:
•

•

The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.
The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.
•
•
•
•
•
•

The name and version number of all products that you think might be causing a problem.
Your computer make and model.
Your operating system version number and details of any networking software you are using.
The amount of memory in your computer.
The relevant page reference or section in the documentation.
Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
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(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.
On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:
•
•

a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.
a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.
To run MFSupportInfo:
1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:
a. To create a .log file, click File > Save.
This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.log, in the %temp% directory.
b. To create a .zip archive, click Tools > Create Zip Package.
This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.zip, in the %temp% directory.
4. Send the diagnostic information to your Micro Focus SupportLine representative:
The following requires an Internet connection and an Email client:
a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.
If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.
Data Manager
When using Data Manager, please be ready to provide the following in addition:
•
•
•
•
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The version number for the z/OS component, found on the Main Menu panel.
Whether you are using the Standard or Client/Server configuration.
The data stores you are working with, including client-side and server-side versions where appropriate.
Details of the data store contents, for example:
DDL, DCLGEN, or SYSPUNCH (for SQL data stores)
Copybooks (SEQ, VSAM, GDG, DL/I)
FDT (ADABAS)
DBD (DL/I)
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Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Copyright and Disclaimer
Copyright © Micro Focus 2018. All rights reserved.
The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.
Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
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